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Notice
While reasonable efforts have been made to ensure that the information in this 
document is complete and accurate at the time of printing, Avaya assumes no 
liability for any errors. Avaya reserves the right to make changes and 
corrections to the information in this document without the obligation to notify 
any person or organization of such changes.

Documentation disclaimer
“Documentation” means information published by Avaya in varying mediums 
which may include product information, operating instructions and performance 
specifications that Avaya generally makes available to users of its products. 
Documentation does not include marketing materials. Avaya shall not be 
responsible for any modifications, additions, or deletions to the original 
published version of documentation unless such modifications, additions, or 
deletions were performed by Avaya. End User agrees to indemnify and hold 
harmless Avaya, Avaya's agents, servants and employees against all claims, 
lawsuits, demands and judgments arising out of, or in connection with, 
subsequent modifications, additions or deletions to this documentation, to the 
extent made by End User. 

Link disclaimer
Avaya is not responsible for the contents or reliability of any linked websites 
referenced within this site or documentation provided by Avaya. Avaya is not 
responsible for the accuracy of any information, statement or content provided 
on these sites and does not necessarily endorse the products, services, or 
information described or offered within them. Avaya does not guarantee that 
these links will work all the time and has no control over the availability of the 
linked pages.

Warranty
Avaya provides a limited warranty on its hardware and Software (“Product(s)”). 
Refer to your sales agreement to establish the terms of the limited warranty. In 
addition, Avaya’s standard warranty language, as well as information regarding 
support for this Product while under warranty is available to Avaya customers 
and other parties through the Avaya Support website: 
http://www.avaya.com/support
Please note that if you acquired the Product(s) from an authorized Avaya 
reseller outside of the United States and Canada, the warranty is provided to 
you by said Avaya reseller and not by Avaya. “Software” means computer 
programs in object code, provided by Avaya or an Avaya Channel Partner, 
whether as stand-alone products or pre-installed on hardware products, and 
any upgrades, updates, bug fixes, or modified versions thereto.

Licenses
THE SOFTWARE LICENSE TERMS AVAILABLE ON THE AVAYA WEBSITE, 
http://support.avaya.com/LicenseInfo/ ARE APPLICABLE TO ANYONE WHO 
DOWNLOADS, USES AND/OR INSTALLS AVAYA SOFTWARE, 
PURCHASED FROM AVAYA INC., ANY AVAYA AFFILIATE, OR AN 
AUTHORIZED AVAYA RESELLER (AS APPLICABLE) UNDER A 
COMMERCIAL AGREEMENT WITH AVAYA OR AN AUTHORIZED AVAYA 
RESELLER. UNLESS OTHERWISE AGREED TO BY AVAYA IN WRITING, 
AVAYA DOES NOT EXTEND THIS LICENSE IF THE SOFTWARE WAS 
OBTAINED FROM ANYONE OTHER THAN AVAYA, AN AVAYA AFFILIATE 
OR AN AVAYA AUTHORIZED RESELLER; AVAYA RESERVES THE RIGHT 
TO TAKE LEGAL ACTION AGAINST YOU AND ANYONE ELSE USING OR 
SELLING THE SOFTWARE WITHOUT A LICENSE. BY INSTALLING, 
DOWNLOADING OR USING THE SOFTWARE, OR AUTHORIZING OTHERS 
TO DO SO, YOU, ON BEHALF OF YOURSELF AND THE ENTITY FOR 
WHOM YOU ARE INSTALLING, DOWNLOADING OR USING THE 
SOFTWARE (HEREINAFTER REFERRED TO INTERCHANGEABLY AS 
“YOU” AND “END USER”), AGREE TO THESE TERMS AND CONDITIONS 
AND CREATE A BINDING CONTRACT BETWEEN YOU AND AVAYA INC. OR 
THE APPLICABLE AVAYA AFFILIATE ( “AVAYA”).

Avaya grants you a license within the scope of the license types described 
below, with the exception of Heritage Nortel Software, for which the scope of 
the license is detailed below. Where the order documentation does not 
expressly identify a license type, the applicable license will be a Designated 
System License. The applicable number of licenses and units of capacity for 
which the license is granted will be one (1), unless a different number of 
licenses or units of capacity is specified in the documentation or other materials 
available to you. “Designated Processor” means a single stand-alone 
computing device. “Server” means a Designated Processor that hosts a 
software application to be accessed by multiple users.

License type(s)
Designated System(s) License (DS). End User may install and use each 
copy of the Software only on a number of Designated Processors up to the 
number indicated in the order. Avaya may require the Designated Processor(s) 
to be identified in the order by type, serial number, feature key, location or other 
specific designation, or to be provided by End User to Avaya through electronic 
means established by Avaya specifically for this purpose.

Concurrent User License (CU). End User may install and use the Software on 
multiple Designated Processors or one or more servers, so long as only the 
licensed number of Units are accessing and using the Software at any given 
time. A “Unit” means the unit on which Avaya, at its sole discretion, bases the 
pricing of its licenses and can be, without limitation, an agent, port or user, an 
e-mail or voice mail account in the name of a person or corporate function 
(e.g., webmaster or helpdesk), or a directory entry in the administrative 
database utilized by the Software that permits one user to interface with the 
Software. Units may be linked to a specific, identified Server.
Named User License (NU). You may: (i) install and use the Software on a 
single Designated Processor or Server per authorized Named User (defined 
below); or (ii) install and use the Software on a Server so long as only 
authorized Named Users access and use the Software. “Named User”, means 
a user or device that has been expressly authorized by Avaya to access and 
use the Software. At Avaya’s sole discretion, a “Named User” may be, without 
limitation, designated by name, corporate function (e.g., webmaster or 
helpdesk), an e-mail or voice mail account in the name of a person or corporate 
function, or a directory entry in the administrative database utilized by the 
Software that permits one user to interface with the Software.
Shrinkwrap License (SR). You may install and use the Software in 
accordance with the terms and conditions of the applicable license 
agreements, such as “shrinkwrap” or “clickthrough” license accompanying or 
applicable to the Software (“Shrinkwrap License”).

Heritage Nortel Software

“Heritage Nortel Software” means the software that was acquired by Avaya as 
part of its purchase of the Nortel Enterprise Solutions Business in December 
2009. The Heritage Nortel Software currently available for license from Avaya 
is the software contained within the list of Heritage Nortel Products located at 
http://support.avaya.com/LicenseInfo/ under the link “Heritage Nortel 
Products”. For Heritage Nortel Software, Avaya grants Customer a license to 
use Heritage Nortel Software provided hereunder solely to the extent of the 
authorized activation or authorized usage level, solely for the purpose specified 
in the Documentation, and solely as embedded in, for execution on, or (in the 
event the applicable Documentation permits installation on non-Avaya 
equipment) for communication with Avaya equipment. Charges for Heritage 
Nortel Software may be based on extent of activation or use authorized as 
specified in an order or invoice.

Copyright 
Except where expressly stated otherwise, no use should be made of materials 
on this site, the Documentation, Software, or hardware provided by Avaya. All 
content on this site, the documentation and the Product provided by Avaya 
including the selection, arrangement and design of the content is owned either 
by Avaya or its licensors and is protected by copyright and other intellectual 
property laws including the sui generis rights relating to the protection of 
databases. You may not modify, copy, reproduce, republish, upload, post, 
transmit or distribute in any way any content, in whole or in part, including any 
code and software unless expressly authorized by Avaya. Unauthorized 
reproduction, transmission, dissemination, storage, and or use without the 
express written consent of Avaya can be a criminal, as well as a civil offense 
under the applicable law.

Third-party components
Certain software programs or portions thereof included in the Software may 
contain software (including open source software) distributed under third party 
agreements (“Third Party Components”), which may contain terms that expand 
or limit rights to use certain portions of the Software (“Third Party Terms”). 
Information regarding distributed Linux OS source code (for those product that 
have distributed Linux OS source code) and identifying the copyright holders of 
the Third Party Components and the Third Party Terms that apply is available 
in the Documentation or on Avaya’s website at: 
http://support.avaya.com/ThirdPartyLicense/ 
You agree to the Third Party Terms for any such Third Party Components.

Preventing Toll Fraud
"Toll fraud" is the unauthorized use of your telecommunications system by an 
unauthorized party (for example, a person who is not a corporate employee, 
agent, subcontractor, or is not working on your company's behalf). Be aware 
that there can be a risk of Toll Fraud associated with your system and that, if 
Toll Fraud occurs, it can result in substantial additional charges for your 
telecommunications services.

Avaya Toll Fraud intervention
If you suspect that you are being victimized by Toll Fraud and you need 
technical assistance or support, call Technical Service Center Toll Fraud 
Intervention Hotline at +1-800-643-2353 for the United States and Canada. For 
additional support telephone numbers, see the Avaya Support website: 
http://www.avaya.com/support. Suspected security vulnerabilities with Avaya 
products should be reported to Avaya by sending mail to: 
securityalerts@avaya.com.

http://www.avaya.com/support
http://www.avaya.com/support
http://support.avaya.com/LicenseInfo/
http://support.avaya.com/LicenseInfo/
http://support.avaya.com/ThirdPartyLicense/


Trademarks
The trademarks, logos and service marks (“Marks”) displayed in this site, the 
Documentation and Product(s) provided by Avaya are the registered or 
unregistered Marks of Avaya, its affiliates, or other third parties. Users are not 
permitted to use such Marks without prior written consent from Avaya or such 
third party which may own the Mark. Nothing contained in this site, the 
Documentation and Product(s) should be construed as granting, by implication, 
estoppel, or otherwise, any license or right in and to the Marks without the 
express written permission of Avaya or the applicable third party.
Avaya is a registered trademark of Avaya Inc.
All non-Avaya trademarks are the property of their respective owners, and 
“Linux” is a registered trademark of Linus Torvalds.
All other trademarks are the property of their respective owners.

Downloading documents
For the most current versions of documentation, see the Avaya Support 
website:
http://www.avaya.com/support 

Contact Avaya Support
See the Avaya Support website: http://support.avaya.com for product notices 
and articles, or to report a problem with your Avaya product.
For a list of support telephone numbers and contact addresses, go to the 
Avaya Support website: http://support.avaya.com, scroll to the bottom of the 
page, and select Contact Avaya Support.

http://support.avaya.com
http://support.avaya.com
http://www.avaya.com/support/
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Preface

This section contains the following topics:

● Purpose on page 13

● Audience on page 13

● Reasons for reissue on page 13

● Documentation Web sites on page 13

● Support on page 14

Purpose
Avaya Call Management System Supervisor Report Designer describes what you need to know 
to create new reports and to edit existing reports through Report Designer and Report Wizard.

Audience
This guide is intended primarily for those who use CMS Supervisor. You should use this guide 
as an information source for creating and modifying CMS Supervisor reports.

Reasons for reissue
No changes have been made to this document in this release.

Documentation Web sites
All CMS documentation can be found at http://support.avaya.com. New issues of CMS 
documentation will be placed on this Web site when available.

http://support.avaya.com


 Preface
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Use the following Web sites to view related support documentation:

● Information about Avaya products and service

http://www.avaya.com 

● Sun hardware documentation

http://docs.sun.com

● Dell hardware documentation

http://www.dell.com

Support

Contacting Avaya technical support
Avaya provides support telephone numbers for you to report problems or ask questions about 
your product.

For United States support: 

1- 800- 242-2121

For international support: 

See the Support Directory listings on the Avaya Web site.

Escalating a technical support issue
Avaya Global Services Escalation Management provides the means to escalate urgent service 
issues.

http://www.avaya.com
http://docs.sun.com
http://www.dell.com
http://support.avaya.com/japple/css/japple?PAGE=avaya.css.OpenPage&temp.template.name=Directories
http://support.avaya.com/japple/css/japple?PAGE=avaya.css.OpenPage&temp.template.name=EscalationList
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Chapter 1: Report Wizard

This section describes the Report Wizard windows and provides an overview of the steps.

Organization of general information
This section contains the following general information:

● About the Report Wizard on page 16

● The Select a Report Type page on page 21

● The Select a Report Layout page on page 23

● The Selection Layout page on page 24

● The Select a Data Group page on page 26

● The Select Data Items page on page 29

● The Select Chart Format page on page 35

● The Select Table Format page on page 38

● The Change Input Captions page on page 41

● The Preview Option page on page 42

● The Save Report page on page 43

● The Finish page on page 45

Organization of procedures
Report Wizard contains the following procedures:

● Overview of Wizard steps on page 19

● Starting Report Wizard on page 20

● Procedures for the Select Data Items page on page 31
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About the Report Wizard
This section includes the following topics:

● What is Report Wizard? on page 16

● Report Wizard and Report Designer on page 16

● Facts about Report Wizard on page 16

● Report Wizard command buttons on page 18

What is Report Wizard?
Report Wizard is a supplement to Report Designer and is available only if you have purchased 
Report Designer. The Report Wizard feature delivers user assistance, by way of a wizard, to 
quickly and easily generate new customized reports. The wizard provides instructional help that 
guides you through a series of tasks that create a new customized report. 

Report Wizard and Report Designer
All reports created with Report Wizard have the same designation and accessibility as those 
created in Report Designer.Thus, reports created by Report Wizard are referred to as Report 
Designer reports. This means that reports created by Report Wizard will be accessible only by 
Avaya Call Management System (CMS) Supervisor users.

Facts about Report Wizard
The following list provides general facts about Report Wizard:

● Report Wizard can access all database items and standard calculations.

Although you can access all database items and standard calculations, you cannot create 
new calculations or link fields together with math functions by way of the Report Wizard. 
However, Report Designer allows you to create new calculations and link fields together 
with math functions for reports that you create in the Report Wizard.

● Report Wizard can create a report with charts and tables.

With the Report Wizard you will be able to create a report that contains the following 
representations:

- One or two charts
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- One or two tables

- One chart and one table

To enter text or fields containing one data item, use Report Designer.

● Report Wizard does not display queries and database table names used to generate a 
report. 

If you need to see this type of information, use Report Designer.

● Report Wizard provides access to database item definitions.

While in the Select Data Items page of the Report Wizard, you can view the definition of a 
database item or calculation.

● Report Wizard does not allow you to edit a completed report.

Report Wizard is designed to create only new reports. To edit a completed report, use 
Report Designer.

● Report Wizard does not allow reentry.

Report Wizard does not allow you to leave and then reenter to finish a partially-completed 
report. Use Report Designer to make changes to a report created and saved in Report 
Wizard.

The following two points apply to CMS Releases 16.2 and later:

● Administrable Agent Group Report Flag

A custom agent group report could fail if there are more than 30 agents in the group and the 
“Agent groups > 30 members” flag is set to “n”.  The system displays the error message 
“Agent Group size exceeds allowable limit.”  This flag is administered only through the 
server ASCII interface in the Report Administration screen under the Maintenance selection 
from the main menu. See section Administering Report Properties in Avaya CMS 
Administration for more information on this topic.

● Administrable Historical Report Timeout Value

A system-wide time limit can be administered that will cause the CMS server to reject a 
custom historical report if it takes longer than the limit to run.  If the report is rejected, the 
system displays the error message “Report timed out.”  The timeout value is administered 
only through the server ASCII interface in the Report Administration screen under the 
Maintenance selection from the main menu.  A timeout value of “never” means there is no 
timeout value. See section Administering Report Properties in Avaya CMS Administration 
for more information on this topic.
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Report Wizard command buttons
Each page of the Report Wizard contains command buttons to help you navigate through 
wizard and define your report. The following table provides an explanation of these command 
buttons.

Command 
button

Action

Back Returns to the previous page. When you back up to previous pages, 
Report Wizard retains the values you entered unless you back up to a 
previous page and make changes that impact ensuing pages.

Next Moves to the next page in the sequence, maintaining whatever 
settings you provided on the previous pages.

Finished Applies your settings, or the default settings, from all pages and 
completes the task.

Cancel Discards any selections you have made if you have not saved the 
report, terminates the process, and closes the Report Wizard.
If you saved the report before you selected Cancel, the Report Wizard 
is closed; however, you will be able to run or edit the report in Report 
Designer.

Help Provides information about the page.

Data Item 
Definition

Provides a definition for the selected database item or calculation.

Moves up one database item or calculation in the list of Selected Data 
Items.

Moves down one database item or calculation in the list of Selected 
Data Items.

Removes a database item or calculation from the Selected Data Items 
list.

Adds a database item or calculation to the Selected Data Items list.

Edit Item 
Heading

Use to edit a database item heading.

Preview Captures a screen shot of your report as it is currently defined.



Avaya CMS R17 Supervisor Report Designer November 2013 19

Overview of Wizard steps
The following chart describes the steps Wizard takes you through.
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Starting Report Wizard
This section includes the following topics:

● Before you begin on page 20

● Starting with the toolbar icon on page 20

Before you begin
You can access Report Wizard only when Report Designer is activated on the Avaya Call 
Management System (CMS) server, and when you have the appropriate permissions to access 
Report Designer.

Starting with the toolbar icon
If you have purchased Report Designer, a toolbar icon will be displayed on the Controller 
window’s toolbar.

To start with the toolbar icon:

1. Select the Report Wizard toolbar icon.

The Report Wizard is displayed.

2. Select Next after you complete each page.

Related topics
For more information about each page, see any of the following topics:

● The Select a Report Type page on page 21

● The Select a Report Layout page on page 23

● The Selection Layout page on page 24

● The Select a Data Group page on page 26

Report Wizard
toolbar button
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● The Select Data Items page on page 29

● Procedures for the Select Data Items page on page 31

● The Select Chart Format page on page 35

● The Select Table Format page on page 38

● The Change Input Captions page on page 41

● The Preview Option page on page 42

● The Save Report page on page 43

● The Finish page on page 45

The Select a Report Type page
Your first task is to select a report type. The report type determines whether the data in the 
report is real-time, integrated or historical. For example, if you select a real-time report, you will 
not be able to specify historical data in the report.

Example
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Types of reports
The following table provides information about each type of report.

Report Description

Real-Time Reports that refresh in real time. Real-time reports are reports that 
display current ACD call activity on agents, splits/skills, trunks, trunk 
groups, vectors, and vector directory numbers (VDNs) for the current 
interval (15, 30, or 60 minutes). Current intrahour interval real-time 
reports are periodically updated as data changes during the interval.

Integrated Reports that refresh in real-time and show information that is 
accumulated from any point in time in the past 24 hours of ACD, 
agent, split/skill, trunk, trunk group, vector, and VDN activities.

Historical Reports that give information tabulated over a period of time. Historical 
reports display past ACD data for various agent, split/skill, trunk, trunk 
group, vector, or VDN activities. You must select a historical report if 
you want to include the following data:
● Exceptions
● Call Work Code
● Agent Trace
● Call Record
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The Select a Report Layout page
Your second task is to choose a report layout. The layout determines how your data will be 
represented in the report. Report layouts can be charts, tables, or both. Charts provide a 
graphical representation of data, and tables provide data in columns and rows. Select on the 
icon the represents the layout you want.
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The Selection Layout page
The Selection Layout page lets you choose which section of the report you want to design.

Report Wizard will take you to this page only if you selected a report layout that contains a table 
and a chart, two tables, or two charts.

Example
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Defining sections
The following table describes the sections of the report.

Description Example

A section that is pressed, with an 
arrow pointing to it, is the section you 
are about to define.

A section that is not pressed, without 
an arrow, is the section you have not 
defined.
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The Select a Data Group page
This section includes the following topics:

● Levels of data groups on page 26

● Expanding and collapsing categories on page 28

Use the Select a Data Group page to select the data you want for this report.

The Select a Data Group page provides only those data groups specific to the type of report 
you chose earlier, and the current section you want to define. For example, if you selected 
historical on the Select a Report Type page, and table on the Select a Report Layout or 
Selection Layout page, you will select data groups only for a historical table.

Example

Levels of data groups
The data groups available are placed in a tree view structure. There can be up to three levels of 
data, the last level containing the individual data groups. From this tree view structure, you will 
select an individual data group for the section you want to define.
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This section includes the following topics:

● First level on page 27

● Second level on page 27

● Third level on page 27

First level

The first level is the highest classification level of data. For example, the highest classification 
levels of data for a real-time table are Agent, Split/Skills (multiple), Trunk Group, VDN (single), 
VDNs (multiple), and Vectors.

Second level

The second level is a breakdown of the first classification level of data. For example, the second 
level of data for the Split/Skills (multiple) category are Multi-ACD, Top Agent Skills Information, 
Expected Wait Time at each priority, Number of Agents in AUX Work States, Performance, Type 
of Agents Staffed, and No Pre-selection. Individual data groups are also contained under this 
level of data.

Third level

The third level is a breakdown of the second classification levels of data. For example, the third 
level of data for the Split/Skills (multiple) Top Agent Skills Information category is Top Agents 
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Staffed and No Pre-selection. If there are three levels of data, the individual data groups will be 
listed under the third level.

Expanding and collapsing categories
Categories of data and sub-categories of data can be expanded (represented with a plus sign) 
and collapsed (represented with a minus sign). By default, when the Select a Data Group page 
of the wizard appears, one category will be expanded with one data group selected. The default 
is based on the information (report type and report layout) that you provided to the wizard 
previously.
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The Select Data Items page
This section includes the following topics:

● Box and button descriptions on page 30

● Data item column descriptions on page 30

● About No Pre-selection on page 31

Use the Select Data Items page to select the specific types of data from the CMS databases 
that you want displayed in your report.

Related topic
For information on how to perform all the available tasks on this page, see Procedures for the 
Select Data Items page on page 31.

Example
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Box and button descriptions
The following table describes the box and buttons on the Select Data Items page.

Data item column descriptions
The following table describes the data item column on the Select Data Items page.

The system displays icons if the data type is alphanumeric or has a graphical representation. 
Synonyms that are defined for data items are in parenthesis.

Box or button Description

Display Data Group items 
that contain

Use this field to display only specific items in both 
columns of the Available Data Items box.
For more information, see Filtering data group items on 
page 32.

Available Data Items Contains all the data items associated with the data 
group. This list allows you to add data items to the 
Selected Data Items box.

Data Item Definition If you highlight a data item in the Available Data Items 
box and select this button, Report Wizard displays a 
topic in Help that defines the data item.

Selected Data Items Contains the predefined database items and 
calculations from the Available Data Items box that 
you want in your report.

Edit Item Heading If you highlight an item heading in the Selected Data 
Items box, and select this button, you can change the 
item heading.

Data item columns Column description

Item Heading Lists the default heading for the database item or 
calculation. The item heading is the heading used in 
standard CMS reports.

Data Item Lists the database item or calculation (internal name).
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About No Pre-selection
If you chose the No Pre-selection data group on the Select a Data Group page, the Selected 
Data Items list view will not be populated with preselected data. However, the Available Data 
Items list view will contain all the data items available for your report. To select the data items 
for your report, you need to manually add them from the Available Data Items list view to the 
Selected Data Items list view. You must have at least one database item or calculation in the 
Selected Data Items list view before the wizard will let you proceed.

Procedures for the Select Data Items page
From the Select Data Items page, you can do the following tasks:

● Filtering data group items

● Sorting data group items

● Moving data group items from one box to another

● Repositioning data group items

● Creating custom report headings
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Filtering data group items
To filter data group items:

1. In the Display Data Group items that contain box, enter the characters of the data items 
that you want Report Wizard to display.

Example:
If you want to list only those data group items that contain the text logonsk, enter

logonsk

1. To re-display all data group items available to the data group, delete all text in the Display 
Data Group items that contain box.

Sorting data group items
To sort the data group items, select the Item Heading column or the Data Item column.

All data group items are sorted alphabetically.
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Moving data group items from one box to another
To move data group items from the Available Data Items box to the Selected Data Items box 
and vice versa, do the following tasks:

Tip:
Tip: You can also double-click an item to move it into the other box.

About removing items

Consider the following when removing items:

● If you remove a calculation from the Available Data Items box, you will have to back up to 
the Select a Data Group page and reselect the data group to have the calculation appear in 
the list again.

● When you remove one or more data group items, ensuing data group items are shifted up 
accordingly.

● If you remove all the data group items in the Selected Data Items box, Report Wizard 
disables Next, and you cannot move to the next page of the wizard. You must leave one or 
more data group items listed in the Select Data Items box.

To move Then

From the Available Data Items 
box to the Selected Data Items 
box

Select one or more data items in 
the Available Data Items box, 
and select the right arrow.

From the Selected Data Items 
box to the Available Data Items 
box

Select one or more data items in 
the Selected Data Items box, 
and select the left arrow.
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Repositioning data group items
You can reorganize data group items through the following methods.

Report Wizard enables up and down arrows only when data group items are selected in the 
Selected Data Items box. 

Creating custom report headings
To change the data item heading:

1. Select the specific data item heading.

2. Select Edit Item Heading.

3. Enter the new heading.

To move items Then

Up Highlight one or more data group items and 
then select the up arrow.

Down Highlight one or more data group items and 
then select the down arrow.
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The Select Chart Format page
This section includes the following topics:

● Select Chart Format field descriptions on page 36

● Available chart formats on page 36

Use the Select Chart Format page to define the format of your chart. The default is a vertical 
2D bar chart that displays the data by value.

Example
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Select Chart Format field descriptions
The following fields are located on the Select Chart Format page.

Available chart formats
You can use any of the following chart formats.

Field Description

Show Value Displays your data as a numeric value.

Show Percentage Displays your data as a percentage.

Display Legend Displays a legend of the data items in the right 
corner of the chart.

Display Data Labels Displays the data labels on your report. The data 
labels are displayed as either values or 
percentages.

Use First data item as chart 
title

Uses the first data item as the title.

2D Vertical Bar 
Chart

3D Horizontal Bar 
Chart

2D Stacked Area 
Bar Chart

2D Horizontal Bar 
Chart

3D Vertical Stacked 
Bar Chart

2D Pie Bar Chart
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2D Vertical Stacked 
Bar Chart

3D Horizontal 
Stacked Bar Chart

3D Vertical Bar 
Chart

2D Horizontal 
Stacked Bar Chart

3D Line Chart 3D Pie Chart

2D Line Bar Chart 3D Stacked Area 
Chart

3D Vertical Cluster 
Bar Chart
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The Select Table Format page
This section includes the following topics:

● Select Table Format field descriptions on page 39

● Example of a row-oriented report on page 39

● Example of a column-oriented report on page 40

Use the Select Table Format page to define the characteristics of your table layout.

Example
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Select Table Format field descriptions
The following fields are located on the Select Table Format page.

Example of a row-oriented report
The following is an example of a row-oriented report.

Field Description

Fill Table by Row Displays your data items horizontally. See 
Example of a row-oriented report.

Fill Table by Column Displays your data items vertically. See Example of 
a column-oriented report.

Display Grid Lines The report will display grid lines to separate the 
data.



 

40 Avaya CMS R17 Supervisor Report Designer November 2013

Example of a column-oriented report
The following is an example of a column-oriented report.
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The Change Input Captions page
When you are finished defining all report sections, the Change Input Captions page is 
displayed. This page allows you to change the input prompts that will appear in the Report 
Input window of your new report.

Example

Input Prompts
The number of entries you see displayed in the Change Input Captions page will depend on 
the data group you assigned to each section of your report. From this page, you can change the 
input captions, but not the inputs that will appear in your report.
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The Preview Option page
The Preview Option page allows you to preview what you have defined for your report and exit 
the preview. You can use Back to modify the report section.

A previewed version of a report contains real data for each completed section; however, if the 
report is designated as real-time, then there will be no refresh of data. The only option while in a 
previewed version of a report is to exit the preview.

Example

Two-section report
When you preview the first section of the report, you will be prompted to provide input values for 
that section. When you preview the second section of the report, you will be prompted to 
provide input for both sections.
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The Save Report page
Use the Save Report page to save your report and define who has permission to access your 
report. Your report will be saved when you enter a report name and select Next. The report type 
and data group selections you made for your report will determine the category your report will 
be saved under. For example, Real-Time.

You are not required to save your report at this time. If you do not save your report, Report 
Wizard will still allow you to advance to the next page.

! Important:! Important:
Important: If you do not enter a report name, your report will not be saved when you 

advance to the Finish page. Report Wizard will discard your report if you do not 
save your report on either the Save Report page or the Finish page.

Example
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Save Report field descriptions
The following table describes the fields on the Save Report page.

Field Description

Report Name Allows you to enter a name for your report. If there is 
an existing report with the same name, and you are 
not the owner of this report, Report Wizard will not 
allow you to overwrite the existing report.

Report 
Description

Provides a space for you to write a description of 
your report.

Everyone Anyone can run the report and copy the report 
design.
The CMS user permission structure is still 
applicable.

Only Me The only users that can run the report and copy the 
design are you and CMS administrators.
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The Finish page
When all the required tasks are completed to create a report, you will have to determine 
whether you want to run the report, edit the report with Report Designer, or exit without doing 
anything.

Example

Finish page field descriptions
The following fields are located on the Finish page.

● Run Report for ACD - Allows you to select the ACD for your report.

● Run Report - When you run your report from the Finish page of the Report Wizard, it will run 
with the appropriate inputs, access the CMS database, and produce real data. You will run a 
live report.

If you run an unsaved report you will be prompted to save the report upon its completion. The 
report will be saved as a Report Designer report and placed in the appropriate folder (real-time, 
historical, or integrated). If you elect not to save your report, you can select Exit, to close the 
report or you can select Return to return to the running report.
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● Edit Report in Report Designer - When you choose to edit your report from the Finish 
page, Report Designer starts. All edits to your report are now done through Report Designer. 
Select the Back button on the wizard pages to edit your report with the Report Wizard.

● Run or Edit report at a later time - Select this option to exit Report Wizard without running 
your report or editing your report. This option is unavailable if you have not entered a report 
name for your report.

There are two ways to exit Report Wizard:

Option 1 Option 2

Select Run or Edit report at a 
later time, and select Finish.

Select Cancel.
If your report has not been 
saved, Report Wizard will discard 
your report. Report Wizard will 
warn you if you try to cancel 
without first saving your report.
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Chapter 2: Using Report Manager

This section describes how to use Report Manager of the Avaya Call Management System 
(CMS) Supervisor application. 

Organization of general information
About Report Manager on page 47

Organization of procedures
This section includes the following procedures:

● Viewing or changing report properties on page 49

● Copying a report to the designer category on page 49

● Copying a designer report to a file on page 52

● Copying a designer report from a file on page 53

● Deleting a report from the designer category on page 54

● Opening Report Designer with Edit or New on page 55

About Report Manager
This section includes the following topics:

● What is Report Manager? on page 47

● The Reports Selector window on page 48

● Buttons on the Report Selector window on page 48

What is Report Manager?
Report Manager is a feature of the Supervisor application that allows you to view report 
properties, copy reports, and access Report Designer to edit reports or create new reports.
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The Reports Selector window

Buttons on the Report Selector window
Use the buttons on the Report Selector window to do the following tasks:

Button Use to …

Script Choose from any number of Windows scripts that 
you have installed on your PC.

Properties Manage the standard CMS and Supervisor reports.

Copy Copy reports to the Designer category for editing.

Delete Delete reports from the Designer category. You 
cannot delete standard CMS, CMS custom, and 
standard Supervisor reports.

Help Opens the context-specific help for the current 
window.

Edit Edit the reports.
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Viewing or changing report properties
Report Manager gives you the ability to view report properties, such as the report name, 
description, owner, type, folder, category, permissions; as well as the folder the report is stored 
in.

To view the report properties:

1. Open the Report Selector window.

2. Select the report for which you want to view properties.

3. Select Properties.

The Properties window for the report is displayed.

4. To change the name, description, or owner of a report, place the cursor in the appropriate 
field and make your edits.

5. To specify who can see the report, select either Everyone or Only Me.

6. When you are done making your changes, select OK to save the changes.

If you attempt to give a report the same name as an existing designer report, the Report 
Already Exists window is displayed. This window allows you to overwrite the existing report 
or to give the report you want to save a different name.

Copying a report to the designer category
Use Report Manager to copy a report from any category into the Designer category of any 
folder. The categories can be Agent, Other, Queue/Agent, Split/Skill, Trunk/Trunk Group, VDN, 
Vector, Custom, or Designer. Folders can be Real-Time, Historical, or Integrated.

This section includes the following topics:

● Where to access your reports on page 50

● Who can modify your reports on page 50

New Create a new Designer report from scratch.

Cancel Cancels any changes or additions you have made 
since the last time you selected OK.

Button Use to …
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● Procedure on page 50

Where to access your reports
You can access reports that you create or edit with Report Designer only from the Supervisor 
interface to the CMS server. Therefore, if you edit an CMS custom report with Report Designer, 
changes to that report will not be available when the report is run from the Terminal Emulator or 
from another terminal interface to the CMS.

Who can modify your reports
No CMS user other than a user with CMS administration permissions can modify a report 
design you create regardless of whether the report is accessible by all or only by you. A user 
with CMS administration permissions always has the ability to modify your report design, even if 
you make it available only to yourself.

Procedure
To copy a report:

1. Open the Report Selector window.

2. Select the report that you want to copy.

3. Select Copy.

The Copy Report window is displayed. This window allows you to select where you want to 
copy the report. You can copy the report to the Designer category, to a PC file, or from a PC 
file to the CMS server.

4. Select To Designer Category.

5. Select OK.

The Copy Report To Designer window is displayed. This window allows you to define the 
name, description, folder, and scope of the report.

6. Enter a name for your report in the Name field. The name can have up to 40 alphanumeric 
characters, including blanks. Because the name you give your report should be unique, you 
may want to look at existing report names before you enter a name for your report.
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7. Move the cursor to the Description field and enter a description of the report. 

The description can have up to 100 alphanumeric characters, including blanks. It is not 
required that you enter a report description.

Do not use the following characters in your description of the report:

● \ (backslash)

● ; (semicolon)

● ’ (grave accent)

● ~ (tilde)

● " (double quote)

● | (pipe)

● * (asterisk)

● ? (question mark)

8. Move the cursor to the Folder field. Use the pull-down list to select Real-Time, Historical, 
or Integrated. 

The report is stored in the Designer category of the folder you select here.

When you edit the report, you will access the database for the folder you select here. If you 
select real-time, you will not be able to access the historical database tables to define 
queries for the report. If you select historical, you will not be able to access the real-time 
database tables to define queries for the report. However, if you select integrated, you will 
be able to access both the real-time and historical databases to define queries for the 
report.

You must select the historical or integrated folder if you want to include the following items:

● Exceptions data

● Agent trace data

● Call record data
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9. Do one of the following tasks:

It is a good idea to initially make your reports available only to yourself until they have been 
debugged and run successfully. This prevents the possibility of other users running reports 
that you have saved but not yet tested.

For more information about assigning access, see Who can modify your reports on 
page 50.

10. Select OK to save the report properties.

Tip:
Tip: After you have copied the report to the designer category, you can use Edit to 

access Report Designer and edit the report.

Copying a designer report to a file
Use the Copy button on the Report Selector window to copy any designer report that you 
create to a file that resides on diskette, on your hard drive, or on a network drive. You can use 
this feature to easily transport designer reports from one PC to another.

If a report was created by Avaya Inc. Professional Services, only a user with CMS services 
permissions can copy the report.

To copy a report, do the following steps:

1. Open the Report Selector window.

2. Select the Designer Category.

3. Select the designer report that you want to copy.

4. Select Copy.

The Copy Report window displays with the To a PC File option enabled. This window 
allows you to select where you want to copy the report. You can copy the report to the 
Designer category, to a PC file, or from a PC file to the CMS server.

5. Select To a PC File.

If … Then …

You want your report to be 
available to everyone

Select Everyone.

You want your report to be 
available only to you

Select Only Me.
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6. Select OK.

The Save Report to PC File window is displayed.

This window is a standard Windows browse window.

7. Select the file name and folder to which you want to save the report.

● You can copy the report to any drive to which you have access, including the floppy drive 
on your PC. This is usually a:\.

● To save the report to a network drive, select Network. This will allow you to access the 
network drives where you have permissions.

8. Select OK.

The file is saved and, upon successful completion of the save, a confirmation window 
displays.

Copying a designer report from a file
Use Report Manager Copy to copy any designer report that has been saved to a file, either on 
diskette or on a network drive, onto the CMS server.

To copy a report from a file to the server:

1. Open the Report Selector window.

2. Select Copy.

The Copy Report window is displayed. This window allows you to select where you want to 
copy the report. You can copy the report to the Designer category, to a PC file, or from a PC 
file to the CMS server.

3. Select From a PC File to the CMS Server.
4. Select OK.

The Load Report From PC File window is displayed.

This window is a standard Windows browse window.

5. Select the file that you want to copy to the CMS server.

6. Select OK.

The file is copied to the CMS server and, upon successful completion of the copy, a 
confirmation window displays.

7. Do one of the following tasks:

● Select Overwrite the existing report to replace the report that currently resides on the 
CMS server.
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● Select Save the report being copied as and enter a new name for the report if you want 
to retain the version of the report that currently resides on the CMS server.

Deleting a report from the designer category
Report Manager allows you to delete any report that resides in the designer category except 
reports purchased from Professional Services. You cannot delete any of the standard CMS, 
CMS custom, or standard Supervisor reports. Standard reports are reports that reside in the 
Agent, Other, Queue/Agent, Split/Skill, Trunk/Trunk Group, VDN, Vector, and Custom 
categories.

To delete a designer report:

1. Open the Report Selector window.

2. Select the Designer category under any tab.

3. Highlight the name of the report that you want to delete.

4. Select Delete.

A message confirming the delete displays.

5. Select OK to delete the report.
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Opening Report Designer with Edit or New
Use one of the following methods to open Report Designer.

If you want to open from … Then …

Report Manager Select a report from the designer 
category and do one of the 
following tasks:
● Select Edit.
● Select New to create a new 

report.

A report output window Select Design from the Report 
menu on the report.

Report Wizard Open from the last page.
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Chapter 3: Report Designer basics

This section outlines the features of Report Designer and describes its general use.

Organization of general information
Report Designer menus on page 57

Organization of procedures
This section includes the following procedures:

● Accessing online database definitions on page 64

● Starting Report Designer on page 65

● Exiting Report Designer on page 66

● Creating a new report on page 67

● Editing an existing report on page 69

Report Designer menus
This section describes Report Designer menus and includes the following topics:

● Report on page 58

● Edit on page 59

● Format on page 60

● Options on page 61

● Insert on page 62

● Help on page 63
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Report
The following is a description of the Report menu.

Menu item Function

Run Takes you out of design mode and runs your report. You will use Run to 
test the changes or additions you have made to a report.

Save Saves your report.

Save As Saves your report with a new name or with the current name.

Exit Closes Report Designer without saving your changes and additions. You 
are prompted to save any changes you made.
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Edit
The following is a description of the Edit menu.

Menu item Function

Undo Cut/
Delete

Undo a cut or deletion.

Undo Align 
Controls

Undo an alignment you made.

Cut Remove an item from the report and place it on the Windows clipboard.

Copy Copy the items that you have selected on the report and place it on the 
Windows clipboard. You can copy only entire tables and entire charts, 
not a portion of a table or chart. If you want to rearrange the order of the 
columns on a grid, use the Format Table window.
You can copy from one report to another report. To do so, complete 
these steps:

1. Open the report from which you want to copy.
2. Select the items that you want to copy.
3. Select Copy from the Edit menu.
4. Open the report to which you want to copy. 
5. Select Paste from the Edit menu.

Paste Place one or more items currently on the Windows clipboard into the 
report that is currently selected in Design Mode.

Delete Remove the currently-selected items from the report.

Align 
Controls

Align multiple fields according to the controls in the Align Controls 
dialog box. This option is enabled only when multiple fields are selected.
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Format
The following is a description of the Format menu.

Inputs Start the Select Inputs assistant, which enables you to choose the 
items that will be included on the report input window for this report.
For instructions on how to use the Select Inputs assistant, see Edit | 
Inputs on page 77.

Queries Start the Create a Query assistant, which is where you define the SQL 
queries that will be used to retrieve the data to be displayed on the 
report.
For instructions on how to use the Create a Query assistant, see Edit | 
Queries on page 93.

Menu item Function

Menu item Function

Chart Opens the Chart Format Options window. Use this window to format 
charts on reports.
For more information about the Chart Format Options window, see 
Format | Chart on page 131.

Field Opens the Field Format Options window. Use this window to format 
fields defined in queries.
For more information about the Field Format Options window, see 
Format | Field on page 169.

Table Opens the Table Format Options window. Use this window to format 
tables on reports.
For more information on the Table Format Options window, see Format 
| Table on page 155.
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Options
The following is a description of the Options menu.

Sort by Opens the Table Format Options window with the Sort by tab active. 
Use this window to access the General and Sort by tabs to format 
tables on reports.
For more information on the Table Format Options window, see Format 
| Table on page 155.

Text Opens the Text Format Options window when a text item on the report 
is selected. Use this window to change the font display characteristics 
for the selected text.
For more information on the Text Format Options window, see Format | 
Text on page 173. 

Menu item Function

Menu item Function

Status Bar Include a status bar on the bottom of the report you want to design. A 
check mark next to the menu item means that you have selected Status 
Bar.

Align To Grid Align the currently-selected items on the report to the Design Mode grid 
when they are moved. The Design Mode grid is the grid that is shown on 
the window behind any charts, tables, or text, when you are in Design 
Mode. Align To Grid is selected when there is a check mark next to the 
menu item.
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Insert
The following is a description of the Insert menu.

Menu item Function

Chart Opens the Chart Assistant, which is where you define the contents of a 
chart. A chart is a graphical presentation of the report information.
This menu item is unavailable if no queries have been defined.
For more information about the Chart Assistant, see Insert | Chart on 
page 111.

Field Opens the Field Assistant, which is where you define the contents of a 
field to be placed on the report.
For more information with the Field Assistant, see Insert | Field on 
page 119.

Table Opens the Table Assistant, which is where you define the contents of a 
table to be placed on the report. A table is a standard Avaya Call 
Management System (CMS) report presentation format.
This menu item is unavailable if no queries have been defined. 
For more information with the Table Assistant, see Insert | Table on 
page 127.

Text Opens the Text Assistant, which is where you can enter plain text that 
will appear on the report.
For more information with the Text Assistant, see Insert | Text on 
page 125.
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Help
The following is a description of the Help menu.

Other ways to access Help

You can access Supervisor Help from all of the windows in Report Designer. You can also use 
one of the following ways to access Help:

● Press F1.

● Select Help (if available).

These methods will provide Help that is specific to the current window.

Menu item Function

Contents Opens the Help Topics dialog for Report Designer.

Technical Support Opens a window that provides technical support information.

About Avaya CMS 
Supervisor

Opens the Supervisor Help About window, which shows the 
software version number.
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Accessing online database definitions
Report Designer provides access to online database item definitions when you want to add 
database items and calculations to a query. With this feature, you do not have to refer to 
hard-copy documentation to learn about database items and calculations.

Example

Procedure
To access the online database item definitions:

1. From a Query Assistant window, highlight the data group item or calculation for which you 
want a definition.

2. Select Data Item definition located under the Calculations box.
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Starting Report Designer
This section includes the following topics:

● About user permissions on page 65

● Different ways to start Report Designer on page 65

● Design Mode window on page 66

About user permissions
To access Report Designer and to run Designer reports, you must have read and write 
permissions assigned for Custom Reports. These permissions are set with the User 
Permissions tool. 

For more information about user permissions, see the Avaya CMS Administration document.

Different ways to start Report Designer
Use one of the following methods to start Report Designer:

● Select a report from the Designer category in any folder and select Edit on the Reports 
Selector window.

● Select New on the Reports Selector window to create a new report.

● Run a report and then select Design from the Report menu on the report.

● Enter Report Designer from the final page of the Report Wizard.
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Design Mode window
You can use any method to start Report Designer and go to the Design Mode window. The 
window will be blank if you want to create a new report or will have report information if you want 
to edit an existing report.

Exiting Report Designer
You can close Report Designer using any of the standard Windows methods:

● Select Exit from the Report menu.

● Double-click System.

● Select Close at the top of the window.

If you try to exit Report Designer without first saving the report you have been working on, a 
warning gives you the opportunity to save the report before you close Report Designer.
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Creating a new report
Do all of the steps in Create a new report to create a custom report. If you consistently do all of 
these tasks for each report you create, your reports will run properly and you will be able to 
create them efficiently.

This section includes the following topics:

● Before you begin on page 67

● Procedure on page 67

Before you begin
You need to know the following before you create a new report:

● If you want to customize the Historical Call Record Report with Report Designer, the 
Disposition report field will display the numerical values for DISPOSITION, and not the state 
names. For more information, see the Avaya CMS Database Items and Calculations 
document.

● With the addition of the split/skill I_OL1TIME and I_OL2 TIME database items, row data will 
be archived for those items if the skill row spent any time in overload 1 or overload 2. If the 
row (skill) spent all of its time in the normal state, and has no other reason to be archived 
(that is, no agent staffed time, no calls handled, and so on), it will not be archived. When you 
create a report through Report Designer, data should be summed across intervals in order to 
see meaningful data.

Procedure
To create a new report:

1. Access Report Designer so that you can design the report.

For more information, see Design mode basics on page 71.

2. Define inputs for the report input window so that users can run the report with parameters 
they choose

For example: split, agent, time, date, and so on.

You can also define inputs while you create a query. To do so, select Inputs on the WHERE 
clause window.

For more information, see Edit | Inputs on page 77.
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3. Define report type and rows of data from specific CMS database tables that will supply data 
for the tables and charts on the report.

For more information, see About queries on page 94.

4. Define what data from the queries should appear in each chart, field, or table on the report.

For more information, see any of the following chapters:

● Insert | Chart on page 111

● Insert | Field on page 119

● Insert | Table on page 127

5. Enter text to provide headings for the tables and charts on the report, and to provide 
additional information, such as the report name. 

This step is optional.

For more information, see Format | Text on page 173.

6. Define fields on the report to show when the report was run and what items the report 
covers (as defined in the report input window).

This step is optional.

For more information, see Insert | Field on page 119.

7. Edit a report design with the Cut, Copy, and Paste Edit menu options and standard 
Windows drag-and-drop conventions. Edit an existing report design to rearrange and delete 
sections of the report quickly and easily.

For more information, see Design mode basics on page 71.

8. Save the report before you test it.

9. Define the name that you use both to run the report and to access the report design if you 
want to change the design. Define access to specify whether other users can run the report 
and can copy the report’s design to create their own custom reports. Define the type as 
real-time, historical, or integrated.

For more information, see Viewing or changing report properties on page 49.

10. Test your report immediately after you design and save it. A test helps eliminate wasted time 
in running a report that has an incomplete design.
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Editing an existing report
Use this procedure to edit an exiting report in Report Designer. If you consistently do all of these 
tasks for each report you want to edit, your reports will run properly and you will be able to 
create them efficiently.

To edit an existing report:

1. Copy an existing report so that you start the design process with existing report headings, 
data fields, queries, charts, tables, and other report features. When you copy a report to the 
Designer category, the original report remains intact and is still located in the original report 
category.

You can also run a report and then select Design from the Report menu. This takes you 
directly into design mode, and you will be asked if you want to save the report (with a new 
name, in the Designer category) when you exit design mode.

For more information, see Copying a report to the designer category on page 49.

2. Define the name that you use both to run the report and to access the report design if you 
want to change the design. Define access to specify whether other users can run the report 
and can copy the report’s design to create their own custom reports. Define the type as 
real-time, historical, or integrated. When you copy a report to the Designer category with 
Report Manager, the Properties window automatically displays as part of the copy process.

For more information, see Viewing or changing report properties on page 49.

3. Access Report Designer so that you can design the report.

For more information, see Opening Report Designer with Edit or New on page 55.

4. Edit a report design with the Cut, Copy, and Paste Edit menu options and standard 
Windows drag-and-drop conventions. Edit an existing report design to rearrange and delete 
sections of the report quickly and easily.

For more information, see Design mode basics on page 71.

5. Define inputs for the report input window so that users can run the report with parameters 
they choose. For example, users can choose the following parameters: split, agent, time, 
date, and so on.

You can also define Inputs while you create a query. To do so, select Inputs on the 
WHERE clause window.

For more information, see Edit | Inputs on page 77.

6. Define which rows of data from specific CMS database tables will supply data for the grids 
and charts on the report. If you copy a report design, the definitions of that report’s queries 
are copied. You can then modify the queries, as required.

This step is optional.

For more information, see About queries on page 94.
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7. Define what data from the queries should appear in each chart, field, or table on the report. 
If you copy a report design, the definitions of that report’s charts, fields, and tables are 
copied. You can then modify the definitions as required.

This step is optional.

For more information, see any of the following chapters:

● Insert | Chart on page 111

● Insert | Field on page 119

● Insert | Table on page 127

8. Enter text to provide headings for the tables and charts on the report, and to provide 
additional information, such as the report name. If you copy a report design, the text of that 
report is copied. You can then modify the text as desired.

This step is optional.

For more information, see Insert | Text on page 125.

9. Define fields on the report to show when the report was run and what items the report 
covers as defined in the report input window. If you copy a report design these fields are 
copied. You can modify them as required.

This step is optional.

For more information, see Insert | Field on page 119.

10. Save the report before you test it.

11. Test your report immediately after you design and save it. A test helps eliminate wasted time 
in running a report that has an incomplete design.
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Chapter 4: Design mode basics

This section describes how to use the basic features of the Report Designer Design Mode 
window.

This section includes the following procedures:

● Copying an item and pasting the item into the same report on page 71

● Copying and pasting items on page 72

● Cutting an item on page 73

● Deleting an item on page 73

● Dragging and dropping to arrange items on page 73

● Resizing an item on page 74

● Selecting multiple items on page 74

● Moving multiple items on page 74

● Changing the width of a column in a table on page 75

● Changing the column headings on page 75

● Aligning fields on page 76

● Scaling to page on page 76

Copying an item and pasting the item into the same 
report

To copy an item in a report and paste the copy into the same report:

1. Open the report from which you want to copy.

2. Select one or more items that you want to copy.

3. Press Control+C.

4. Go to where you want to paste the items and press Control+V.

The system places items in the upper-left corner of the Design Mode window.
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Copying and pasting items
This section includes the following topics:

● Copying from a Designer report on page 72

● Copying from a report that is not a Designer report on page 72

Copying from a Designer report
To copy items from one report to another report:

1. Open the report from which you want to copy.

2. Select the items that you want to copy.

3. Press Control+C.

4. Open the report to which you want to paste what you have copied.

5. Press Control+V.

Note:
Note: Open both reports in design mode to copy from one report to another report.

Copying from a report that is not a Designer report
To copy an item from a report that is not a Designer report:

1. Run the report.

2. Select Design from the Report menu.

3. Copy the item to the clipboard.

See Copying from a Designer report on page 72.

4. Select Run from the Report menu.

One of the following occurs:

● If you did not make any changes to the report, you will automatically be returned to the 
run mode.

● If you inadvertently made changes to the report, Supervisor displays a message that 
gives you the option to save the changes. 

5. Select No if you made changes that you do not want to save.
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Cutting an item
To cut an item from a report and place the information on the Windows clipboard:

1. Select the item.

2. Press Control+X.

Deleting an item
Use this procedure to permanently remove the currently-selected items from the report.

To delete an item from a report:

1. Select the item.

2. Press Delete.

The item is removed from the report and is no longer available to be pasted into the report.

Restoring an accidently-deleted item
If you accidentally delete an item that you want to keep in the report, you can select Undo from 
the Edit menu if you have not done anything else. If you do not immediately realize that you 
inadvertently deleted an item, use the Insert menu to recreate the item.

Dragging and dropping to arrange items
To reposition one or more items on a report with the drag-and-drop method:

1. Point the cursor at the item and click one time to select one or more items.

To select additional items, hold down Control and click the cursor on the items.

You will know when an item is selected because there will be a frame around the item or 
sizing handles will display on the corners of the item.

2. Hold down the left mouse button.

3. Move the cursor to the position where you want the item to reside.

4. Let go of the mouse button.
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Resizing an item
To resize an item on a report:

1. Select the item.

2. Place the mouse cursor over one of the sizing handles on the item.

3. Press the left mouse button.

4. Drag the mouse cursor until the item is the appropriate size.

5. Release the mouse button.

Selecting multiple items
To select multiple items on a report (for instance, to copy more than one item at a time):

1. Select the first item.

2. Hold down Control.
3. Select the second item. 

Handles are displayed around the items.

Moving multiple items
To move the group of items on a report:

1. Place the cursor within the selected items.

2. Hold down the left mouse button and drag the selected items to the desired area. There is a 
visual indication that your selected items will move as a group with the cursor. As you move 
the selected items, an outline of the items is displayed and then moves with your cursor. 
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3. Once the items are in the desired location, release the mouse button. The selected items 
are displayed in the desired location.

Changing the width of a column in a table
You can quickly and easily change the column widths in your table while in the design mode. 

To change a column width:

1. Place the mouse pointer on the border between the column heading. The mouse pointer 
changes to the following shape: 

2. Hold down the left mouse button and drag the column border to the left or right. The column 
width automatically decreases or increases depending on how you move the column 
border.

Changing the column headings
You can quickly and easily change the column headings in your table while in the design mode. 

To change a column heading:

1. Select the heading name you want to change. A dialog box is displayed with the current 
heading highlighted.
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2. Enter the new name of the heading in the Name text box.

3. Select OK.

Aligning fields
This section includes the following topics:

● Align menu items on page 76

● How to use align on page 76

Align menu items
The Report Designer Edit menu has two menu items:

● Align Controls
● Undo Align Controls

How to use align
You can select multiple fields and align them in various ways. You can undo the alignment if you 
are not satisfied with the results.The Align Controls dialog box provides six alignment choices. 
When you select multiple fields, an outline around the fields appears. Any alignment choice you 
select will align the fields within this outline.

Scaling to page
When you print a report that is too large to fit on one page, you will be prompted with one or 
more messages. The number of messages will depend on the size of your report. The 
messages will ask if you want the Scale to Page function to attempt to fit your report onto one 
page.
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Chapter 5: Edit | Inputs

This section describes the Edit | Inputs menu option.

Use the Edit | Inputs menu option to add, delete, and edit the input fields for a Report Designer 
report.

Organization of general information
This section includes the following general information:

● The Report Input fields on page 78

● Information about how to add input fields on page 80

● Input fields for pattern matching on page 81

● Input Types on page 83

Organization of procedures
This section includes the following procedures:

● Adding input fields to the input window on page 85

● Deleting input fields from the input window on page 86

● Editing the order of input fields on page 86

● Editing the appearance of input fields on page 87

● Setting up inputs for a multi-ACD report on page 89

● Viewing the input window on page 91
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The Report Input fields
This section includes the following topics:

● The Report Input window on page 78

● The Define Input window on page 78

● Example of input window on page 79

● How CMS stores and retrieves data on page 79

The Report Input window
To run a report, you first access a Report Input window. The Report Input window gives you 
control over which splits/skills, trunks, dates, intrahour intervals, and so on are included in the 
report.

The Define Input window
To define report input fields for a designer report, use the Define Input window. When you or 
another user runs the report, this input window is displayed with the field prompts and the input 
fields you defined.

You define fields for the Report Input window when you use the steps described in the 
following topics.
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Example of input window
In the example input window that is shown below, the user has entered a split number of 1, a 
date of 07/01/96, and intrahour intervals of 8:00 a.m. to 11:00 a.m.

How CMS stores and retrieves data
Because the report this input window is associated with is a Historical Interval report, Avaya Call 
Management System (CMS) will retrieve the data for the report from the historical database 
tables, which are designated with an h, such as hagent, hsplit, htrunk, and so on.

Related topics
For more information on how CMS stores and retrieves data, refer to either of the following 
resources:

● Appendix B: How CMS stores and retrieves data on page 183

● Avaya CMS Database Items and Calculations document
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Information about how to add input fields
This section includes the following topics:

● Why define an input field? on page 80

● Add only relevant information on page 80

● Fields you do not define on page 80

Why define an input field?
When you define the type of an input field, CMS will be able to do the following when your users 
run the report:

● Check that user entries are valid system values and are values CMS can use to search the 
database tables.

● Check your users for permission to run a report for the entries.

● Allow your users to enter names defined in the Dictionary subsystem.

Add only relevant information
Add inputs that are only used in the report queries. If you add additional inputs that are not used 
in the queries, then irrelevant information that references those inputs will be displayed on the 
input window for the report.

Fields you do not define
You will not need to define the following input fields:

● If you want to define a real-time report, you cannot and do not need to define an Update 
Rate in Seconds input field because the field is automatically included in the Report Input 
window.

● If you want to define a historical report, you cannot and do not need to define a Report 
Destination input field because the field is automatically included in the Report Input 
window.

● If you want to define an integrated report, you cannot and do not need to define a Start Time 
input field because the field is automatically included in the Report Input window.
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Related topic

For the procedure, see Adding input fields to the input window on page 85.

Input fields for pattern matching
This section includes the following topics:

● What is pattern matching? on page 81

● Database items that allow search on page 81

● Using an asterisk on page 82

● Using a question mark on page 82

● Using String as an input field on page 82

What is pattern matching?
CMS can search for values in certain database items according to wild card search patterns. As 
a result, you can create a report that allows inputs based on the following items:

● Character strings

● An asterisk, which matches blank and all characters

● A question mark, which matches any single character

CMS then reports data for all items that match entered values.

Database items that allow search
The standard database items that allow pattern matching are as follows.

Database 
item

Value

VDN A Vector Directory Number

EXTENSION An extension number

LOGID An agent login ID
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In addition, any custom database items that you define as CHAR columns in the CMS database 
also allow pattern matching.

Using an asterisk
You can search with an asterisk (*). If an input field is a string type and is associated with the 
LOGID database item, the user can enter 1*, and CMS will report data for all agents with login 
IDs that start with 1. 

Using a question mark
You can search with a question mark (?). If an input field is a string type and is associated with 
the VDN database item, the user can enter 21?0, and CMS will report data for all VDNs that 
start with 21, end with 0, and have any single character appearing between the 21 and the 0, for 
example 2100, 2110, 2120, 2130, and so on.

Using String as an input field
If you select String for an input field, CMS does not check user inputs in that field for 
appropriate read permissions or valid parameters. If you want CMS to check permissions for a 
VDN input field, you must select the VDN field type. If you want CMS to check parameters for a 
VDN, login ID, extension, or call work code input field, you must select that field type, not 
String. In addition, if you select String for a field, the user will not be able to enter Dictionary 
names. So, again, if you want to let the user enter VDN, login ID, or call work code names to run 
a report, you must select that specific field type, not String.

EQLOC A 9-digit trunk location number

CWC A call work code

ROW_DATE A date when data was collected

Database 
item

Value
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Input Types
The following table describes the input types and what type of information the user must enter.

For this type of input: The user must enter the following information:

ACD An ACD number or name.

Agent An agent name as defined in the Dictionary or agent login ID.
The Agent input field can only be a single-value input for 
integrated reports.

Agent group An agent group name as defined in the Dictionary.
Use the following query:

ACD=$acd and OLDEST_LOGON > 0 and LOGID in 
(select value from agroups where 
acd_no=$acd and item_name = [Agent 
Group:])

Agent state An agent state name. This can be a standard or new name as 
defined in the Dictionary. Standard names are ACD, AUX, 
ACW, and so on.

Call Work Code Call work code names or numbers.

Date A date in region-specific format or as a relative number. For 
example, use -7 for 7 days ago.

Extension An extension number.

Location ID A location ID can be assigned to either an agent or to a trunk 
equipment location.
● The location IDs are actually assigned to the agent 

terminal, and are associated with the port network to which 
terminals are assigned. Agent location IDs are available 
only for agents who are currently logged in. Agent location 
IDs are part of the Agent Site Tracking feature.

● Trunk location IDs are assigned to the trunk equipment 
location, and are associated with the communication 
server port network location. The trunk equipment location 
ID is part of the Multi-Locations feature on the 
communication server.

Login ID A login ID.
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Number A number that may include digits to the right of the decimal 
point. This type applies if your variable field asks for specific 
values about ACD performance. For example, use the number 
of ACD calls or percent within the service level.

Split/Skill A split/skill number or name.

String A character string. Select this type only if one of the following 
is true:

● Your variable field is linked to a custom database item that 
you identify in the CMS database as a CHAR column.

● Your variable field is linked to a standard database item 
that is a CHAR column, and you want to allow the user to 
do a pattern search when running the report. For more 
information, see Input fields for pattern matching on 
page 81.

Time
(duration)

A number, including decimals, of seconds. This type applies 
only if your variable field asks for specific values regarding 
ACD performance. For example, use time in AUX work, 
average speed of answer, or average talk time.

Time 
(point in time)

A specific time of day in hh:mm format, either as 24-hour time 
or with AM or PM appended.

Trunk A trunk name or number.
The Trunk input field can only be a single-value input for 
integrated reports.

Trunk group The number or name of a trunk group.

Trunk state A trunk state name. The trunk state name can be a standard 
name or new name as defined in the Dictionary subsystem. 
Standard names are IDLE, SEIZED, QUEUED, and so on.

Note:
Note: If you use Trunk state as an input in an 

integrated report, use a real-time query. You 
cannot use Trunk state in an integrated query.

VDN A Vector Directory Number (VDN) name.
The VDN input field can only be a single-value input for 
integrated reports.

Vector A vector number or name.
The Vector input field can only be a single-value input for 
integrated reports.

For this type of input: The user must enter the following information:
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Adding input fields to the input window
This section includes the following topics:

● Before you begin on page 85

● Procedure on page 85

Before you begin
Read the following topics before you do this procedure if you have not done so already:

● Information about how to add input fields on page 80

● Input fields for pattern matching on page 81

● Input Types on page 83

Procedure
To define the input fields for a report:

1. Select Inputs from the Edit menu.

An Edit Inputs window is displayed.

● If you want to edit an existing report, the items that already appear on the input window 
for the report are shown in the Inputs list. 

● If you want to create a new report, the Inputs list is blank.

2. In the Input Types list, highlight the first input you want to require for the report. 

For definitions of the available input types, see Input Types on page 83.

3. Select Add.

The item is displayed on the Inputs list.

4. Repeat Step 2 until you have added all of the inputs required for the report.
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Deleting input fields from the input window
This section includes the following topics:

● Before you begin on page 86

● Procedure on page 86

Before you begin
If a field is used in a query, you cannot remove the input until you remove or modify the query.

Procedure
To delete one of the inputs you have added for a report input window:

1. Select Inputs from the Edit menu.

2. On the Inputs table, select the left-numbered column of the row to highlight the row of the 
item.

3. Select Remove.

Editing the order of input fields
To change the order in which input fields appear on the report input window:

1. Select Inputs from the Edit menu.

2. Add the Input Types that will appear on the input window to the Inputs table.

3. Select the left-numbered column of the row to select the entire row of the input that contains 
the fields you want changed.

4. Press Up and Down to move the entire row up or down one row at a time.

5. Use the Inputs list to edit the name of the prompt for each input field, control whether 
multiple values are allowed in the input field, and define the ACD with which the input will be 
associated.

6. When you are finished with your edits, select OK.
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Editing the appearance of input fields
Use the Inputs list to edit the name of the prompt for each input field, control whether multiple 
values are allowed in the input field, and define the ACD with which the input will be associated.

Example

Edit columns
When you add an item from the Input Types list to the Inputs list, the columns of the Inputs 
table are populated with the default values for that input item. The columns of the Inputs table 
are as follows:

Column Function

Type The Type column shows the input field name. You can use the 
pull-down list to the right of the column to change the input in a 
particular row to another type.

Multi-value Select Multi-Value if you want to allow users to enter multiple values in 
the input field.
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Prompt The prompt column shows the text that will display on the report input 
window for this input field. To edit the text for the prompt, select the cell 
in the table and then enter the text that you want to display. If you want 
to delete the existing prompt text, use backspace to erase the letters.
You can enter a name of up to 30 characters long, including blank 
spaces.
The prompt name should describe the information (what split/skill, 
what date, what time, and so on) you must enter in the field when you 
order the report. For example, if you want to enter a date, Date would 
be an appropriate prompt. However, if you can enter more than one 
date in the field, Dates would be more appropriate.

Associated 
ACD

The Associated ACD column lets you use the Current ACD or assign 
a specific ACD to be used for this input. The default for this column is 
Current ACD. If you want to allow the user to pick a specific ACD for 
the input field, use the pull-down list to the right of the column to select 
ACD. If the Associated ACD column is blank, the input cannot be 
associated with a specific ACD.
Select Current ACD if either of the following conditions is true:
● You have only one ACD

● You always want the report to show data for the current ACD for 
the user

Select ACD if the people who run the report have read permissions for 
more than one ACD. Allowing the user to select the ACD for the input 
is most useful when you create a multi-ACD report. 

Default Value You can define a default value for most input fields. To do this, select 
browse to the right of the column. The available values for this type of 
input are displayed. Highlight one and select OK.
If you select a default value, the user can change the value on the 
input window.

Column Function
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Setting up inputs for a multi-ACD report
Use this procedure to create a multi-ACD report. Make sure that you set up the inputs as 
detailed in this procedure so that the query for the report will work properly.

This section includes the following topics:

● Types of multi-ACD reports on page 89

● Procedure on page 89

Types of multi-ACD reports
The following types of multi-ACD reports are available:

● Multi-ACD reports that show data for multiple splits/skills on multiple ACDs

● Multi-ACD reports that show data for multiple VDNs on multiple ACDs

Procedure
The following instructions use the split/skill multi-ACD report inputs as an example. To create 
the inputs for a VDN multi-ACD report, use the same instructions, but use the VDN input instead 
of the Split/Skill input.

To create the inputs for a multi-ACD report that allows inputs for up to four ACDs:

1. Select Inputs from the Edit menu.

2. Select ACD from the Input Types box.

3. Select Add.
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4. Repeat Steps 2 and 3 three times.

The Inputs table will have three more ACD entries that are followed by numbers:

5. Select Split/Skill from the Input Types box.

6. Select Add.

7. Repeat Steps 5 and 6 three times.

The Inputs table will have four split/skill entries that are followed by numbers:
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8. For the Split/Skill(2) prompt on line 6 of the Inputs table, use the Associated ACD 
drop-down list to select ACD(2) as the associated ACD.

9. For the Split/Skill(3) prompt on line 7 of the Inputs table, use the Associated ACD 
drop-down list to select ACD(3) as the associated ACD.

10. For the Split/Skill(4) prompt on line 8 of the Inputs table, use the Associated ACD 
drop-down list to select ACD(4) as the associated ACD.

The Inputs table will have each split/skill matched to the corresponding ACD:

11. Select OK to save the inputs for this multi-ACD report.

Viewing the input window
When to view - To view what the input window will look like, select Run from the Report menu.

Returning to design mode - To return to the design mode from the report input menu, select 
Cancel.
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Chapter 6: Edit | Queries

This section describes the Edit | Queries menu option.

A report consists of fields, charts, and grids that display data that is retrieved from the Avaya 
Call Management System (CMS) database tables. Use a query to define what data is retrieved 
for a specific report.

Organization of general information
This section includes the following general information:

● About queries on page 94

● The Query Assistant window on page 95

● Select a database and one or more tables for the query window on page 96

● Add the database items and calculations for the SELECT portion of the query window on 
page 97

● Choose functions for the SELECT items window on page 98

● Enter the SQL WHERE criteria window on page 99

● Specify all field joins for the tables window on page 101

Organization of procedures
This section includes the following procedures:

● Create a new query for a real-time report on page 101

● Create a new query for a historical report on page 102

● Create a new query for an integrated report on page 104

● Edit an existing real-time or historical query on page 106

● Edit an existing integrated query on page 107

● Copy a query on page 108

● Delete a query on page 109
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About queries
To complete the definition of a report's tables, charts, or fields, you must define the queries that 
select the rows of the appropriate tables in the CMS database.

This section includes the following topics:

● What are queries? on page 94

● About columns and rows on page 94

What are queries?
Queries are values for either database items or calculations. In most cases, the queries specify 
the input variables, rather than specific values, as criteria to retrieve information from the 
database. The input variables allow CMS to use the values entered in the Report Input window 
as the query criteria for the report. 

If you change the prompt in the Edit Inputs window, it is automatically updated in the query.

Queries provide the CMS server with the following information:

● Where to get the data

● How to use the data

About columns and rows
CMS selects values from a table with both row and column identifiers. CMS identifies rows of 
data according to the user's inputs and the row search conditions you define. CMS identifies 
columns according to the data expression you define.

Related topics
For more information, see the Avaya CMS Database Items and Calculations document.
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The Query Assistant window
Use the Query Assistant window to define what data is retrieved for a specific report.

This section includes the following topics:

● Query Assistant input fields on page 96

● Data Item definition on page 96

Example
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Query Assistant input fields
The following table describes the Query Assistant input fields.

Data Item definition
Use Data Item definition to see a definition of the database item or calculation.

Select a database and one or more tables for the 
query window

The Table list includes the database items you can include in the query. For real-time and 
integrated reports, you can select only one table name. For historical reports, you can select up 
to three table names.

Note:
Note: The calculations that are associated with the database items in the tables you 

choose will also be available for you to use in your query.

Field Description

Database 
Items

Shows a list of all of the available database items, based on the tables 
you selected on the Select a database and one or more tables for 
the query window. If you selected more than one historical database 
table to be used in the query, the table names are appended to the 
database item names. For example, wsplit.acdtime.

Calculations Shows a list of all of the available calculations, based on the tables you 
selected on the Select a database and one or more tables for the 
query window.

Other Use this box to enter a database item name, calculation name, or other 
acceptable SELECT statement item (such as ACD) for the query.

Query Items Shows a list of all of the database items and calculations that you have 
made available for use in the query.
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Related topic
For information on the database items and calculations available in each table, see the Avaya 
CMS Database Items and Calculations document.

Add the database items and calculations for the 
SELECT portion of the query window

Use this window to add and remove database items and calculations that you want included in 
the query.

This section includes the following topics:

● Tasks on page 97

● Database Items or Calculations on page 97

Tasks
Use the Query Assistant window to do the following tasks:

● Use Move Up and Move Down to change the order of the items in the Query Items box.

● Remove an item from the list, highlight an item in the Query Items list, and then select 
Remove.

● Edit an item in the Query Items box, highlight the item, and then select Edit. The Select Edit 
window is displayed. 

Example:
To create a custom calculation in the edit box, add callsoffered - to the abncalls item. This 
changes the item to callsoffered - abncalls.

Database Items or Calculations
Enter the names of database items or calculations, strings, or constants that you want to use in 
the query by typing them in the Other text box.

Note:
Note: In a query involving a division operation, the number of query items is limited to 

seven.
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Example: If you want the report to include information that subtracts the quantity of one 
database item from the quantity of another database item (for instance, ACDCALLS - 
ACDAUXOUTCALLS), then enter a - in the Other text box and add it to the list of Query 
Items. When you create the WHERE clause for the query, you can specify a calculation of 
ACDCALLS - ACDAUXOUTCALLS for the report.

Note:
Note: Constants that have been defined in the Dictionary are listed in the Calculations 

box in addition to the calculation.

Choose functions for the SELECT items window
Use the Query Assistant window to assign AVG, MAX, MIN, and SUM aggregate functions to 
the Query Items.

This section includes the following topics:

● Definition of function on page 98

● Types of functions on page 98

Definition of function
A function is a prefix that is attached to a database item, a calculation, parts of a calculation, or 
a calculation name. Avaya CMS will display only one value on the report if a SUM, AVG, MIN, or 
MAX aggregate function is assigned to a database item or calculation. 

Types of functions
The available aggregate functions are described in the following table.

Aggregate 
function

Description

MAX Retrieves the highest value for a calculation or database item over the 
time frame of the report

MIN Retrieves the lowest value for a calculation or database item over the 
time frame of the report
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Enter the SQL WHERE criteria window
Use this Query Assistant window to define the SQL WHERE clauses that you want to use to 
retrieve data for the report. The SQL WHERE clause tells the CMS to retrieve the data defined 
in the SELECT box that matches the criteria defined in the WHERE box. The SELECT box 
specifies which columns of data to consider in the database tables. The WHERE box species 
which rows of data to consider in the database tables.

Tips using this window
You can add your own text, such as parenthesis and numbers, in the WHERE clause by placing 
your cursor where you want the text to display and typing in the text.

If you want to create a report that will display data for multiple splits/skills or VDNs on multiple 
ACDs, you can enter MULTI_ACD in the WHERE clause, instead of entering each individual OR 
statement. This will only work if you have correctly set up the inputs for the multi-ACD report.

SUM Retrieves the sum of all values for a calculation or database item over 
the time frame of the report

AVG Retrieves the average of all values found over the time frame of the 
report

Aggregate 
function

Description
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Field descriptions

This window includes the following fields:

The ACD operand is automatically added to the beginning of each WHERE clause.

Item Description

SELECT box Shows the Query Items that were defined on the previous windows, 
including the database items and calculations and any associated 
functions assigned to the items and the database table from which the 
database items and calculations are to be retrieved.
The information displayed in the SELECT box cannot be edited.

Operand1 
box

Lists the database items and calculations that can be used in the 
WHERE clause.

Operator box Lists the standard mathematical operations that can be used in the 
WHERE clause.

Operand2 
box

Lists the database items, calculations, and inputs that can be used in the 
WHERE clause and as inputs for the input window.

WHERE box Shows the current WHERE clause.

AND button Places an AND before the currently-selected Operand1, Operator, and 
Operand2. If you place AND between clauses, then both of the clauses 
must be true in order for CMS to retrieve the SELECT data from the 
table.

OR button Places an OR before the currently-selected Operand1, Operator, and 
Operand2. If you place OR between clauses, then either of the clauses 
can be true in order for CMS to retrieve the SELECT data from the table.

New Input Takes you to the Edit Inputs window, where you can add new input 
fields for the Report Input window. Any new inputs you add will display 
in the Operand2 box.

Test button Allows you to test the query for basic SQL syntax errors.
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Specify all field joins for the tables window
Use this Query Assistant window to ensure that items between two or three tables are equal in 
order to be used in the report. 

Example: You might want to select the ACD item from each agent and make a join clause to 
ensure that the report is for the same ACD information across the tables.

Create a new query for a real-time report
To create a new query for a real-time report:

1. Select Query from the Edit menu.

The Query Select window is displayed.

2. Select New.

A Query Assistant window is displayed. For more information on this window, see Select a 
database and one or more tables for the query window on page 96.

3. Select Real-Time Database.

4. In the Table list, highlight the name of the table that include the database items that you 
want to include in the query. For real-time reports, you can select only one table name.

5. Select Next.
A Query Assistant window is displayed. For more information on this window, see Add the 
database items and calculations for the SELECT portion of the query window on page 97.

6. In either the Database Items or Calculations box, highlight the first database item or 
calculation that you will reference in the query.

7. Select Add or double-click the item.

The item is listed in the Query Items box.

8. Repeat Steps 6 and 7 until all of the database items and calculation that you want 
referenced in the query are listed in the Query Items box.

9. Select Next.
A Query Assistant window is displayed. For more information on this window, see Choose 
functions for the SELECT items window on page 98.

10. Highlight the first Query Item that you want to assign an aggregate function.

11. Highlight the Function that you want to assign an aggregate function.
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12. Repeat Steps 10 and 11 until you have assigned Functions to the appropriate Query 
Items.

13. Select Next.
A Query Assistant window is displayed. For more information on this window, see Enter 
the SQL WHERE criteria window on page 99.

14. In the Operand1 box, highlight the first database item or calculation that you want 
considered in the WHERE clause.

15. In the Operator box, highlight the appropriate operation.

16. In the Operand2 box, highlight the second database item or calculation that you want 
considered in the WHERE clause. 

Example: If you wanted the report to select the data from the table when the number of 
ACDCALLS is greater than the number of ACWINCALLS, you would select acdcalls in the 
Operand1 box, the > sign in the Operator box, and ACWINCALLS in the Operand2 box.

17. Select AND or OR, as appropriate.

18. Repeat Steps 14 through 17 until you have completed the query.

19. Select Test. 
CMS checks the syntax of the query and returns a message with any errors. For more 
information, see Appendix A: Error messages on page 175.

20. Correct any of the errors detected in the test.

21. Select Next. 
A Query Assistant window is displayed. Use this window to give your query a new name.

22. In the Name text box, enter the name that you want to assign to the query you created.

23. Select Done.

Create a new query for a historical report
To create a new query for a historical report:

1. Select Query from the Edit menu. 

The Query Select window is displayed.

2. Select New. 

A Query Assistant window is displayed. For more information, see Select a database and 
one or more tables for the query window on page 96.
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3. Select Historical Database. 

The tables that are available for the historical database display.

4. In the Table list, highlight the names of the tables that include the database items that you 
want to include in the query. For historical reports, you can select up to three table names.

5. Select Next.
A Query Assistant window is displayed. For more information, see Add the database items 
and calculations for the SELECT portion of the query window on page 97.

6. In either the Database Items or Calculations box, highlight the first database item or 
calculation that you will reference in the query.

7. Select Add or double-click the item. The item is listed in the Query Items box.

8. Repeat Steps 6 and 7 until all of the database items and calculations that you believe will be 
referenced in the query are listed in the Query Items box.

9. Select Next. 
A Query Assistant window is displayed. For more information, see Choose functions for 
the SELECT items window on page 98.

10. Highlight the first Query Item that you want to assign an aggregate function.

11. Highlight the function that you want to assign to the item.

12. Repeat Steps 10 and 11 until you have assigned functions to the appropriate Query Items.

13. Select Next.
14. Do one of the following tasks:

15. Highlight an item in one of the table lists.

16. Highlight an item in one or both of the remaining table lists.

17. Select Join. The join clause is shown in the Join Criteria box.

18. Repeat Steps 15 through 17 until all of the necessary join clauses are listed.

If Then

You did not select more than one 
historical database table for your 
query

Go to Step 20.

You selected the Historical 
Database for your query and you 
are using more than one table in the 
query

The Specify all field joins for the tables window 
is displayed. For more information about this 
window, see Specify all field joins for the tables 
window on page 101.
Go to Step 15.
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19. Select Next. 
A Query Assistant window is displayed. For more information, see Enter the SQL WHERE 
criteria window on page 99.

20. In the Operand1 box, highlight the first database item or calculation that you want 
considered in the WHERE clause.

21. In the Operator box, highlight the appropriate operation.

22. In the Operand2 box, highlight the second database item or calculation that you want 
considered in the WHERE clause.

Example: If you wanted the report to select the data from the table when the number of 
ACDCALLS is greater than the number of ACWINCALLS, you would select acdcalls in the 
Operand1 box, the > sign in the Operator box, and ACWINCALLS in the Operand2 box.

23. Select AND or OR, as appropriate.

24. Repeat Steps 20 through 23 until you have completed the query.

25. Select Test. CMS checks the syntax of the query and returns a message with any errors. 
For more information, see Appendix A: Error messages on page 175.

26. Correct any of the errors detected in the test.

27. Select Next. 
A Query Assistant window is displayed. Use this window to give your query a new name. 

28. In Name, enter the name that you want to assign to the query you created.

29. Select Done.

Create a new query for an integrated report
To create a new query for an integrated report:

1. Select Query from the Edit menu.

The Query Select window is displayed.

2. Select New.

A Query Assistant window is displayed. For more information, see Select a database and 
one or more tables for the query window on page 96.

3. Select Database next to Integrated.

The tables that are available for integrated reports are displayed.
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4. In the Table list, highlight the name of the table that includes the database items or 
calculations that you want to include in the query.

For integrated reports, you can select one table per query.

For information on the database items and calculations available in each table, see the 
Avaya CMS Database Items and Calculations document.

5. Select Next.
A Query Assistant window is displayed. For more information, see Add the database items 
and calculations for the SELECT portion of the query window on page 97.

6. In either the Database Items or Calculations box, highlight the first database item or 
calculation that you will reference in the query.

7. Select Add.

The item is listed in the Query Items box.

8. Repeat Steps 6 and 7 until all of the database items and calculations that you believe will be 
referenced in the query are listed in the Query Items box.

9. Select Next.
A Query Assistant window is displayed.

10. Select Input Start Time or Select Start Time Now. 

11. Do one of the following tasks:

12. Select Next.
A Query Assistant window is displayed. On this window, you can choose the input item 
that will be used for the query.

13. Highlight the inputs you want to use as criteria for the query. You can create a new input by 
selecting New Input, that takes you to the Edit Inputs assistant.

Only the inputs that apply to the table you selected for this query are displayed.

14. Select Next.
A Query Assistant window is displayed. On the Query Assistant: Select the input used 
to indicate the agent or split/skill for this query window, you can choose the input item 
that will be used for the query.

If you selected Then

Select Start Time 
Now

Define the time that the integrated data will always begin 
accumulating for this report.

Input Start Time A Start Time field will be added to the report input window and users 
can individually define the time that data will begin accumulating for 
the report.
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15. In the Name text box, enter the name that you want to assign to the query you created.

16. Select Done.

Edit an existing real-time or historical query
Complete the following steps from the Report Designer Design Mode window.

To edit an existing real-time or historical query used in a Designer Report:

1. Select Query from the Edit menu.

The Query Select window is displayed.

2. In the Queries box, highlight the name of the query you want to edit.

3. Select Edit.
A Query Assistant window is displayed. The Database Items and Calculations that are 
already included in the query are listed in the Query Items list.

4. Do one of the following tasks:

Example:
To edit an item, create a custom calculation in the edit box. For instance, you may add 
callsoffered - to the abncalls item, so that the item would then read callsoffered - 
abncalls. That is the calculation that would be available for you to use in the query.

5. Repeat Step 4 until all of the database items and calculations that you believe will be 
referenced in the query are listed in the Query Items box.

6. Select Where.

A Query Assistant window is displayed. For more information, see Enter the SQL WHERE 
criteria window on page 99.

If you want to … Then …

Add database items or calculations to the 
Query Items list

Select Add.

Remove a database item or calculation 
from the Query Items list

Highlight the item in the list and then select 
Remove.

Edit a database item or calculation on the 
Query Items list

Highlight the item in the list and then select 
Edit.
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7. In the Operand1 box, highlight the first database item or calculation that you want 
considered in the WHERE clause.

8. In the Operator box, highlight the appropriate operation.

9. In the Operand2 box, highlight the second database item or calculation that you want 
considered in the WHERE clause.

Example: If you want the report to select the data from the table when the number of 
ACDCALLS is greater than the number of ACWINCALLS, you would select acdcalls in the 
Operand1 box, the > sign in the Operator box, and ACWINCALLS in the Operand2 box.

10. Select AND or OR, as appropriate.

11. Repeat Steps 7 through 10 until you have completed the query.

You can add your own text in the WHERE clause, such as parenthesis and numbers, by 
placing your cursor where you want the text to display and enter in the text.

12. Select Test.
CMS checks the syntax of the query and returns a message with any errors.

13. Correct any of the errors detected in the test.

14. Select Save.

The changes to the query are saved and the Query Select window is displayed.

Edit an existing integrated query
Complete the following steps from the Report Designer Design Mode window.

To edit an existing integrated query used in a Designer Report:

1. Select Query from the Edit menu.

The Query Select window is displayed.

2. In the Queries box, highlight the name of the integrated query you want to edit.

3. Select Edit.
A Query Assistant window is displayed. For more information, see Add the database items 
and calculations for the SELECT portion of the query window on page 97.

4. In either the Database Items or Calculations box, highlight the first database item or 
calculation that you will reference in the query.

5. Select Add or double-click the item.

The item is listed in the Query Items box.
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6. Repeat Steps 4 and 5 until all of the database items and calculations that you believe will be 
referenced in the query are listed in the Query Items box.

7. Select Next.
A Query Assistant window is displayed.

8. Select Input Start Time or Select Start Time Now. 

● If you select Select Start Time Now, you need to define the time that the integrated data 
will always begin accumulating for this report.

● If you select the Input Start Time, a Start Time field will be added to the report input 
window and users can individually define the time that data will begin accumulating for 
the report.

9. Select Next.
A Query Assistant window is displayed. Use this window to choose the input item that will 
be used for the query.

10. Highlight the inputs you want to use as criteria for the query. You can create a new input by 
selecting New Input, that takes you to the Edit Inputs assistant.

Only the inputs that apply to the table you selected for this query are displayed.

11. Select Save.

Copy a query
To copy an existing query, complete the following steps from Report Designer Design Mode:

1. Select Query from the Edit menu.

The Query Select window is displayed.

2. In the Queries box, highlight the name of the query you want to copy.

3. Select Copy.

The Copy Query window is displayed.

4. In the To text box, enter the name you want to assign to the copied query.

5. Select OK.

The query is copied to the new name and the Query Select window is displayed, including 
the new query in the Queries list.
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Delete a query
! Important:! Important:

Important: If you delete a query that is used in the report, the report will not run.

Complete the following steps from Report Designer Design Mode.

To delete an existing query:

1. Select Query from the Edit menu.

The Query Select window is displayed.

2. In the Queries box, highlight the name of the query you want to delete.

3. Select Delete.

A message confirming the delete is displayed.

4. Select OK to delete the query.
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Chapter 7: Insert | Chart

This section describes the Insert | Chart menu option.

Once you have defined queries for a report, you can use those queries to add a chart to your 
report using the Chart Assistant, which is accessed by selecting Chart from the Insert menu.

This section includes the following topics:

● Information about how to insert charts on page 111

● Inserting a chart on page 114

Related topic
For more information about defining queries for a report, see Edit | Queries on page 93.

Information about how to insert charts
This section includes the following topics:

● About inserting charts on page 111

● About charts and tables on page 112

● About fields and text on page 112

● About adding and removing items on page 112

● Stacked, % Axis, and Gradiant field descriptions on page 113

● About the Chart Assistant window on page 113

About inserting charts
There are two things to keep in mind when inserting charts onto a report:

● When you insert a chart on a report, the chart is shown with sample data. This helps you 
visualize how the chart will display when you run the report.
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● Each item is initially inserted in the upper-left corner of the report. You need to drag-and-drop 
the chart to the location where you want it to be displayed on the report.

About charts and tables
If the report includes both a chart and a table, you need to place the chart above the table on 
the report. The reason for this is that if the table spans multiple pages when printed and if the 
chart is below the table, the table will print above the chart.

About fields and text
Do not position any fields or text over the chart because the chart will be displayed over the field 
or text, so that the field or text are not visible.

About adding and removing items
The following items should be read and understood about the adding and removing of items:

● Use Move Up and Move Down to arrange the items in the order in which you want them 
displayed on the chart.

● Items that are added to the Data on Chart box are shown in the chart you want to create.

● The maximum number of columns that can be included on a chart is 16.

● If you want to create a chart that uses categories and series as controls on the axis, you 
need to verify that the first item listed on the Data on Chart box is the item that you want to 
use as the series for the chart.
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Stacked, % Axis, and Gradiant field descriptions
The following table describes the Stacked, % Axis, and Gradiant field descriptions.

About the Chart Assistant window
Use this window to define how the data will be displayed on the axis of the chart.

Column descriptions

There are three columns used to define the category and series for the chart. The information 
gathered by each column is as follows:

● Column 1 - Category (can be none)

● Column 2 - Series (usually Split)
● Column 3 - Data

In the following example, the Category (Column 1) is the Time that was selected on the input 
window, the Series are the Splits that were selected on the input window, and the Data is the 
data that was retrieved from the Avaya Call Management System (CMS) database for those 
splits/skills on the specified date for the specified time period. 

Field Description

Stacked Displays the data for all series as stacked rather than displaying the 
data separately. This check box is disabled for pie charts.

% Axis Displays the value axis (y-axis) as percentages rather than as 
actual data values. You can combine this with the stacked check 
box to produce a percentage-stacked chart.

Gradient Specifies the backdrop of a chart as a solid color, a gradient, or as a 
smooth transition from one color to another. The gradient transition 
can be one of the following items:
● Horizontal
● Vertical
● Rectangle
● Oval
The quality of the gradient effect will vary, depending on the video 
card installed in the PC, and for printed reports, on the capabilities 
of the printer.
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Example

Inserting a chart
This section includes the following topics:

● Before you begin on page 114

● Procedure on page 115

Before you begin
Read Information about how to insert charts on page 111, if you have not already done so.

Category
Series

Data

(Column 1)
(Column 2)

(Column 3)
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Procedure
To insert a chart in your report:

1. Select Chart from the Insert menu.

The first window of the Chart Assistant is displayed.

2. From the Queries drop-down list, select the query from which you want to take data for the 
chart. 

Note:
Note: Any created queries that still include errors are unavailable.

The Available Data box is populated with the data that was previously defined for the query.

3. Use Add, Add All, Remove, and Remove All to add items from the Available Data box to 
the Data on Chart box and to remove items.

For more information, see About adding and removing items on page 112.

4. Select Next.
A Chart Assistant window is displayed.

To change any of the options you select in the following steps at any time after you insert 
the chart on the report, select the Format | Chart menu item.

5. Do one of the following tasks:

6. From the Chart Types box, select which type of chart you want to display. If you are not 
sure what each type of chart will look like, you can highlight the type and an example of the 
chart displays on the right side of the window.

7. Select Stacked, % Axis, and Gradient, as appropriate.

For more information, see Stacked, % Axis, and Gradiant field descriptions on page 113.

Note:
Note: Select Stacked if you want to select % Axis.

8. Select the Rolling check box if you want the real-time chart report to scroll through the 
refreshes as they occur. If you select the Rolling check box, you need to define the Number 
of Data Points, or refreshes, that you want included on the chart.

If you want the chart to display in … Then select …

Two-dimensional format 2D

Three-dimensional format 3D
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9. Select Next.
A Chart Assistant window is displayed. 

For more information, see About the Chart Assistant window on page 113.

10. In the Category Available Data box, select the database item that you want to use as the 
category for the chart. The Category is usually none for real-time charts, or a time 
database item for historical charts. As you select from the list of available items, the 
currently selected item moves to the top of the Available Data list and the example on the 
right side of the window reflects what the chart might look like with that item selected as the 
chart Category.

11. Select the Show Value as Name check box if you want to show the selected category as a 
Dictionary name. 

Note:
Note: This check box is available only when the selected category is an item that can 

be defined in the Dictionary.

12. Select the Format in which the category will display. Use the drop-down list to select from 
the applicable formats for the selected category. If you want to view all of the available 
formats for all types of data, select the Show All Formats check box.
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13. Select the One Data Value per Row check box to show one line of data when multiple rows 
of data are retrieved in the query. When One Data Value per Row is selected, the first item 
listed in the Category Available Items box is the item that is used for the chart category.

The previous example showed a report with One Data Value per Row selected. 

Example: 
This is an example of the same report, using the same Category item (STARTTIME), 
without One Data Value per Row selected.

In the first example, you can see that the report shows one row of data for the interval 
beginning at 10:00 AM, one row of data that includes information for each split/skill for the 
interval beginning at 10:30 AM, and one row of data for the interval beginning at 11:00 AM. 
In the second example, there is a row of data shown for each split/skill for each interval.

14. Select Done.
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Chapter 8: Insert | Field

This section describes the Insert | Field menu option.

The time or date when a report is run is not stored in any database table. The Avaya Call 
Management System (CMS), if requested, displays information from the start time 
specified by the user (for integrated and historical data). Similarly, CMS knows what the 
currently selected ACD is when you run a report and can display the current ACD name or 
number on the report.

Organization of general information
Information about how to insert fields on page 119

Organization of procedures
This section includes the following procedures:

● Using the Field Assistant window on page 120

● Inserting an ACD Name field on page 121

● Inserting Data Item fields on page 122

● Inserting Input Value fields on page 123

● Inserting a Report Data Start Time field on page 123

● Inserting a Time Report Run field on page 124

Information about how to insert fields
This section includes the following topics:

● About Field Assistant on page 120

● Positioning a field on page 120

● Editing a field on page 120
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About Field Assistant
The Field Assistant allows you to insert fields in a designer report to display the report's 
run-time, run-date, current ACD, data, or any of the fields that were specified as being 
required in the report input window. Select Field from the Insert menu to access the Field 
Assistant.

Positioning a field
Each item is initially inserted in the upper-left corner of the report. You will need to 
drag-and-drop the field to the location where you want it to be displayed on the report.

Editing a field
To edit a field:

1. Select the field. 

2. Choose Field from the Format menu.

Using the Field Assistant window
To use the Field Assistant window:

1. Select Field from the Insert menu.

The Field Assistant Select a field type window is displayed.

2. Select an item from the Types list.

Note:
Note: The Report Data Start Time type is available only with an Integrated 

Report.
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3. Do one of the following tasks:

4. Select Done.

The field is inserted in the upper-left corner of the report.

Inserting an ACD Name field
! Important:! Important:

Important: Do not position the field over any tables or charts because the table or chart 
will be displayed over the field so that the field will not be visible.

To insert the name of the ACD for which the report was run:

1. Select Field from the Insert menu.

The Field Assistant wizard is displayed.

2. Highlight ACD Name in the Types box.

3. Select Done.

The ACD name field is placed in the upper-left corner of the report.

4. Select the item and drag-and-drop it to the location where you want it displayed in the 
report.

If you highlighted … Then …

ACD Name, Report Data Start Time, or 
Time Report Run

Go to Step 4.

Data Item Select Next.
Go to the Field Assistant: Select a query 
and associated data item for this field 
window.

Input Value Select Next. 
Go to the Field Assistant: Select an input 
for your field window. 
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Inserting Data Item fields
This section includes the following topics:

● Before you begin on page 122

● Procedure on page 122

Before you begin
Before you can insert a data item on a report, the data item must be used in a query that is 
associated with this report.

Procedure

! Important:! Important:
Important: Do not position the field over any tables or charts because the table or chart 

will be displayed over the field, and the field will not be visible.

To insert data item fields on the report:

1. Select Field from the Insert menu.

The Field Assistant wizard is displayed.

2. Highlight Data Items in the Types box.

3. Select Next.
A Field Assistant window is displayed.

4. Highlight the name of the query from which you want to select the data item.

The available data items for the selected query display in the Available Data box.

5. Highlight the data item that you want to display on the report.

6. Select Done.

The Data Item field is placed in the upper left corner of the report.

7. Select the item and drag-and-drop it to the location where you want it displayed in the 
report.
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Inserting Input Value fields
! Important:! Important:

Important: Do not position the field over any tables or charts because the table or chart 
will be displayed over the field, and the field will not be visible.

To insert input value fields on the report:

1. Select Field from the Insert menu.

The Field Assistant wizard is displayed.

2. In the Types box, highlight the Input Value.

3. Select Next.
The Select an input for your field window is displayed.

4. Highlight the name of the input that you want to show on the report, or create a new 
input by selecting New Input. The Edit Inputs wizard is displayed. For information 
about how to create inputs for a report, see Edit | Inputs on page 77.

5. Select Done.

The Input Value field is placed in the upper left corner of the report.

6. Select the item and drag-and-drop it to the location where you want it displayed in the 
report.

Inserting a Report Data Start Time field
! Important:! Important:

Important: Do not position the field over any tables or charts because the table or chart 
will be displayed over the field, and the field will not be visible.

This type of field applies to only integrated reports.

To insert the initial start time (the time at which data begins accumulating) for an integrated 
report:

1. Select Field from the Insert menu.

The Field Assistant wizard is displayed.

2. In the Types box, highlight Report Data Start Time.
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3. Select Done.

The Report Data Start Time field is placed in the upper-left corner of the report.

4. Select the item and drag-and-drop it to the location where you want it displayed in the 
report.

Inserting a Time Report Run field
! Important:! Important:

Important: Do not position the field over any tables or charts because the table or chart 
will be displayed over the field, and the field will not be visible.

To insert on the report the time at which the report was run:

1. Select Field from the Insert menu.

The Field Assistant wizard is displayed.

2. In the Types box, highlight Time Report Run.

3. Select Done.

The Time Report Run field is placed in the upper left corner of the report.

4. Select the item and drag-and-drop it to the location where you want it displayed in the 
report.
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Chapter 9: Insert | Text

This section describes the Insert | Text menu option.

Report Designer allows you to include text strings with no associated data on your report. You 
will use the Text option from the Insert menu to add items such as the report name to your 
designer reports. 

This section includes the following procedures:

● Positioning and editing text on page 125

● Inserting text on page 126

Positioning and editing text
This section includes the following topics:

● Positioning text on page 125

● Editing text on page 125

Positioning text
Each item is initially inserted in the upper-left corner of the report. You will need to 
drag-and-drop the text to the location where you want it to be displayed on the report.

Editing text
To edit text:

1. Select the text.

2. Select Text from the Format menu.
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Inserting text
! Important:! Important:

Important: Do not position the text over any tables or charts because the table or chart will 
be displayed over the text, and the text will not be visible.

To insert a text string on a report:

1. Select Text from the Insert menu.

The Text Assistant window is displayed.

2. Enter the text that you want to display on the report in the Text contents field.

3. Do one of the following tasks:

4. Select Font.
The Font selector window is displayed.

5. Select the Font, Style, Point size, Effects, and Script that apply to the text string you want 
to create.

6. Select OK.

7. On the Text Assistant window, select OK to insert the text string and close the window, or 
select Apply to apply the changes you made and keep the window open.

The text is inserted, by default, in the upper-left corner of the Design Mode window. You 
can use the cut, copy, or drag-and-drop method, as outlined in Report Designer basics on 
page 57, to move the text to the appropriate location on the report.

If you want to … Then …

Select a specific font for the text Go to Step 4.

The default font set Go to Step 7.
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Chapter 10:Insert | Table

This section describes the Insert | Table menu option.

Once you have defined the queries that you want to use for a report, you can use those queries 
to add a table to the report with the Table Assistant. To access Table Assistant, select Table 
from the Insert menu.

This section includes the following procedures:

● Positioning and editing tables on page 127

● Inserting a table on page 128

Related topic
For more information about defining queries, see Edit | Queries on page 93.

Positioning and editing tables
This section includes the following topics:

● Positioning a field on a table on page 127

● Editing a table on page 127

Positioning a field on a table
Each item is initially inserted in the upper-left corner of the report. Drag-and-drop the field to the 
location where you want it to be displayed on the report.

Editing a table
To edit a table:

1. Select the table.
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2. Select Table from the Format menu.

Inserting a table
This section includes the following topics:

● Before you begin on page 128

● Procedure on page 128

Before you begin
If the report includes both a chart and a table, place the chart over the table on the report. The 
reason for this is, if the table spans multiple pages when printed and if the chart is below the 
table on the report, the table will print over the chart so that you cannot see the chart.

Procedure

! Important:! Important:
Important: Do not position text and fields over the table because the table will be displayed 

over the text/field, and the text/field will not be visible.

To insert a table on a report:

1. Select Table from the Insert menu.

A Table Assistant window is displayed.

2. From the Queries drop-down list, select the query from which you want to take data for the 
table.

Note:
Note: Any created queries that still include errors are unavailable.

The Available Data box populates with the data that was previously defined for the query.

3. Use Add, Add All, Remove, and Remove All to add items from the Available Data box to 
the Data on Table box and remove items.

● Use Move Up and Move Down to place the data items shown in the Data on Table box 
in the order you want them to be displayed on the table.

● Items that are added to the Data on Table box are shown in the table you want to create.
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4. Select Next.
The Table Assistant window is displayed.

Note:
Note: You can change any of the options you select in Steps 5 through 10 after you 

have inserted the table with Format | Table.

5. Select either Horizontal or Vertical to define the orientation of the table.

6. Add a Summary line to the table by doing one of the following tasks:

7. Select the Headers On check box if you want to include column headers on the table.

8. Select the Grid Lines On check box if you want the table to include lines between the 
columns and rows.

9. Choose one of the following tasks:

If … Then …

You want to place the Totals line at the top 
of the table as standard CMS reports do

Select Top.

You want to place the Totals line at the 
bottom of the table

Select Bottom.

You do not want to include a Totals line on 
this table

Select None.

If … Then …

You elected not to include a 
Summary line on the table

Select Done.
The Table Assistant is closed 
and the table is placed on the 
report template.

You elected to include a 
Summary line on the table

Select Next and go to the next 
step.
A Table Assistant window is 
displayed.
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10. Choose one of the following tasks:

11. Select Build a New Query.

12. Enter a name for the summary query in the Name field.

13. Edit the table to include the database items and summary information that is appropriate for 
this summary query.

14. Go to Step 17.

15. Select Select an Existing Query.

A Table Assistant window is displayed.

16. Select the name of one of the existing queries from the drop-down Queries list.

17. Select Done.

If you want to … Then …

Create a new query for the summary 
line on this table

Go to Step 11.

Use an existing query for the summary 
line on this table

Go to Step 15.
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Chapter 11: Format | Chart

This section describes the Format | Chart menu option. 

Report Designer allows you to format report charts after they have been inserted on the report. 
You will use the Chart option from the Format menu to edit charts on your designer reports. 

Organization of general information
This section includes the following general information:

● Information about how to format charts on page 132

● General tab on page 134

● Axis tab on page 136

● Data tab on page 140

● Data Labels tab on page 142

● Fonts tab on page 144

● Legend tab on page 145

● Series Labels tab on page 147

● Title tab on page 148

● Type tab on page 150

● 3D Effects tab on page 152

Organization of procedures
This section includes the following procedures:

● Changing general chart parameters on page 135

● Changing axis titles on page 139

● Adding, removing, or rearranging data items on page 141

● Defining data labels on data points on page 143

● Changing fonts on page 145

● Formatting the chart legend on page 146

● Editing data item headings on page 148

● Formatting the title on page 149
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● Selecting a chart type on page 151

● Controlling the 3D appearance on page 154

Information about how to format charts
This section includes the following topics:

● What are charts? on page 132

● About the Chart Format Options window on page 133

● How to access the window on page 133

● How your changes affect others on page 133

What are charts?
Charts provide a graphical representation of data. Values or data points are displayed in formats 
such as bars, lines, filled areas, and pie charts. These data points are grouped into series that 
are identified with unique colors. In many chart types, one data point from each series is 
grouped together by category across an axis. A chart can also have a title and a legend. 
Categories are plotted along the x-axis, values are plotted along the y-axis. A two-dimensional 
chart shows series next to each other, while a three-dimensional chart plots series along the 
z-axis.

Example

Title

Legend

X-Axis

Y-Axis

Z-Axis

Series Labels
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About the Chart Format Options window
The Chart Format Options window gives you access to the General, Axis, Data, Data Labels, 
Fonts, Series Labels, Legend, Title, Type, and 3D Effects tabs for formatting charts on 
reports.

How to access the window
If the report you want to design includes a chart, you can format how the chart is displayed and 
what is displayed on the chart. Access the Chart Format Options window by doing any of the 
following tasks:

● Double-click a chart in the report.

● Select Chart from the Format menu.

● Select Format Chart from the right mouse button pop-up menu.

How your changes affect others
The changes you make to a report’s format affect only your view of the report. The changes do 
not affect how other CMS users see the report unless you are in Design Mode.
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General tab
Select the General tab to specify several general options that apply to the chart.

Example

General tab options
You can change the following chart parameters:

● Background Color - You can specify whether the backdrop of the chart is a solid color or 
whether it is displayed as a gradient. The gradient transition can be one of the following 
options: horizontal, vertical, rectangle, or oval. The quality of the gradient effect will vary 
depending on what video card is installed in the PC. The quality of the gradient effect for 
printed reports depends on the capabilities of the printer.

● Options - Select the check boxes, as appropriate, to include or omit grid lines, chart borders, 
and legend borders on the report.

● Real-Time - If the chart is part of a real-time report and is a rolling chart, you can specify the 
number of data points to be displayed in the chart. Permitted values are 2 through 100, with 
10 the default. A rolling chart is a line chart that is initially displayed with no data points. For 
each refresh of the report, a data point is added. As data points are added, the chart “rolls” 
from left to right. When enough refreshes have occurred that the chart displays the number of 
specified data point, at the next refresh, the oldest data point is dropped from the display and 
the newest data point is displayed.
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Changing general chart parameters
To change general chart parameters:

1. In the Background Color box, select Report Background, Solid, or Gradient.

2. In the Options box, select the check boxes, as appropriate.

● Select Grid Lines On to include the lines between rows and columns on any grid that 
displays on the chart.

● Select Chart Border On to include a border around the chart.

● Select Legend Border On to include a border around the chart legend.

3. If the report you want to design is a real-time report, or if it is a real-time component of an 
integrated report, you can make the chart a rolling chart. To do this, select the Rolling 
Chart check box and then define the Number of Data Points that you want displayed on 
the chart. 

Permitted values for the number of data points are 2 through 100.

4. Select Apply to make the changes and to keep the Chart Format Options window open.

5. Select OK to make the changes and to close the Chart Format Options window.

If you select … Then …

Report 
Background

The background of the report will default to the color 
you set on the Options Report Colors tab which is 
accessed from the Controller Tools menu.

Solid Select the square next to the Background Color 
option to set the color of the report background.

Gradient The report background will combine the two colors you 
select in the squares to the right of the Gradient 
Colors option.
You can select the type of gradient that will be used 
from the drop-down list below the Gradient option. 
The available types are horizontal, vertical, rectangle, 
and oval.
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Axis tab
Use the Axis tab to specify the title that will be displayed on each axis of the chart report.

Example

Axis tab options
You can change the following chart parameters:

● Axis Display on page 136

● Category on page 137

Axis Display

Makes each of the axes visible or invisible. The choices are X Axis, Y Axis, 2nd Y Axis, and Z 
Axis. 

The 2nd Y Axis is available only for bar charts. Select this check box to display the y-axis 
information on the right side of the bar chart. This is in contrast to the standard y-axis that 
displays on the left side of the chart.

The Z Axis is available only for 3D bar charts. Select this check box to make the chart look 
3-dimensional.
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Category

Select the category, or database item, that you want to use as the x-axis on the chart. You can 
use the drop-down menu to select any of the database items you included in the query for this 
chart. 

● Category for X-Axis - This item is the same as the Available Items box in the Insert Query 
Chart Assistant. Select the database item that you want to use as the category for the chart. 
The Category is usually none for real-time charts, or a time database item for historical 
charts.

There are three columns used to define the category and series for the chart. The 
information gathered by each column is as follows:

- Column 1 - Category (can be none)

- Column 2 - Series (usually Split)
- Column 3 - Data

● Show Value as Name - This item shows the selected category as a Dictionary name.

● Format - Use the drop-down list to select the applicable formats for the selected category. If 
you want to view all of the available formats for all types of data, select the Show All 
Formats check box.

● One data value per row - Shows one line of data when multiple rows of data are retrieved in 
the query. When One Data Value per Row is selected, the first item listed in the Category 
for X-Axis drop-down list is the item that is used for the chart category.
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Example 1
In the following example, the Category (Column 1) is the time that was selected on the input 
window, Series are the splits that were selected on the input window, and Data is the data that 
was retrieved from the CMS database for those splits/skills on the specified date for the 
specified time period. Also, the Show Value as Name field was not checked.

Category
Series

Data

(Column 1)
(Column 2)

(Column 3)
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Example 2
The previous example showed a report with One Data Value per Row selected. Following is an 
example of the same report, with the same Category item (STARTTIME), without One Data 
Value per Row selected.

In the first example, you can see that the report shows one row of data for the interval beginning 
at 10:00 AM, one row of data that includes information for each split/skill for the interval 
beginning at 10:30 AM, and one row of data for the interval beginning at 11:00 AM. In the 
second example, there is a row of data shown for each split/skill for each interval.

Changing axis titles
To change the title that will display on each axis of the chart report:

1. Depending on the type of chart you are formatting, select the appropriate Axis check box.

The following are examples of chart types: bar, line, area, step, clustered bar, horizontal bar, 
or pie as selected on the Type tab.

2. In the appropriate text box, enter the title you want assigned to the axis.

3. In the Category for X-Axis box, which is the same as the Available Items box in the Insert 
Query Chart Assistant, select the database item that you want to use as the category for 
the chart. The Category is usually none for real-time charts, or a time database item for 
historical charts. 
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4. Select the Show Value as Name check box if you want to show the selected category as a 
Dictionary name. This check box is available only when the selected category is an item 
that can be defined in the Dictionary.

5. Select the Format in which the category will be displayed. 

Use the drop-down list to select from the applicable formats for the selected category. If you 
want to view all of the available formats for all types of data, select the Show All Formats 
check box.

6. Select the One Data Value per Row check box to show one line of data when multiple rows 
of data are retrieved in the query. 

When One Data Value per Row is selected, the first item listed in the Category for X-Axis 
drop-down list is the item that is used for the chart category.

7. Do one of the following actions:

● Select Apply to make the changes and to keep the Chart Format Options window 
open.

● Select OK to make the changes and to close the Chart Format Options window.

Data tab
Use the Data tab to add, remove, or rearrange data items in the chart. The available data items 
are the data items that are specified in the query that this chart uses.

Example
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Data tab options
You can change the following chart parameters:

● Available Data - Lists all of the data items that are available, based on the query you used 
for the chart or table.

● Data on Chart - Displays the data items that are currently used in the chart.

Adding, removing, or rearranging data items
To add, remove, or rearrange data item:

1. Do one of the following actions:

2. Select Apply to make the changes and to keep the Chart Format Options window open.

3. Select OK to make the changes and to close the Chart Format Options window.

To … Then select an item on the Data on 
Chart list and …

Add data items to the chart Select Add.

Remove data items from the chart Select Delete.

Rearrange the order in which items display 
on the chart

Use Up and Down to move the item to the 
appropriate place on the list.
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Data Labels tab
Use the Data Labels tab to define where the labels of each data point on the chart will be 
displayed and to define how the labels will be displayed.

Example

Data Labels tab options
You can specify the following parameters:

● None - No labels are displayed.

● Above Point - The label is displayed above the data point. This location is valid only for bar, 
line, area, and step charts.

● Below Point - The label is displayed below the data point. This location is valid only for bar, 
line, area, and step charts.

● Center - The label is displayed centered on the data point. This location is valid only for bar, 
line, area, and step charts.

● Base - The label is displayed along the category axis, directly beneath the data point. This 
location is valid only for bar, line, area, and step charts. 

● Inside - The label is displayed inside a pie slice. This location is valid only for pie charts.

● Outside - The label is displayed outside a pie slice. This location is valid only for pie charts.
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● Left - The label is displayed to the left of the related data point.

● Right - The label is displayed to the right of the related data point.

If data point labels are displayed, you can specify that they include one of the following display 
options:

● Value - The value of the data point displays in the label.

● Percent - The value of the data point displays in the label as a percentage.

● Series Name - The series name is used to label the data point.

● Category Name - The category name is used to label the data point.

The position of data point labels can affect the readability of the chart. The label text may 
overlap in some situations, making it difficult or impossible to read the labels.

Defining data labels on data points
To define where the labels of each data point on the chart will be displayed, and to define how 
the labels will be displayed:

1. In the Location box, select the location where you want the data point labels to display on 
the chart.

2. In the Show Label Text box, select the option that corresponds with how you want the data 
point labels to display on the chart.

3. Select Apply to make the changes and to keep the Chart Format Options window open.

4. Select OK to make the changes and to close the Chart Format Options window.
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Fonts tab
Use the Fonts tab to edit the fonts of the title, data point labels, legend, axes, and series labels 
on the chart report.

Example

Fonts tab options
You can specify the following parameters:

● Fonts - Lists all of the available report items for which you can edit the fonts.

● Choose Font - Takes you to the Font selector window, where you can edit the font size and 
style for each type of text.
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Changing fonts
To change the fonts:

1. Select Choose font next to the report item for which you want to change the font.

The Font window is displayed.

2. Select the Font, Font style, Size, Effects, Color, and Script that you want assigned to the 
selected text.

3. Select OK.

The Chart Format Options window is displayed.

4. Select Apply to make the changes and to keep the Chart Format Options window open.

5. Select OK to make the changes and to close the Chart Format Options window.

Legend tab
Use the Legend tab to control the location of the chart legend.

Example
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Legend tab options
The available options on the Legend tab are as follows:

● Visible check box - Allows you to display or not to display the report legends.

● Location of legend - If you elect to have report legends visible, you can select where the 
legend is displayed. The available options are Top Left, Top (center), Top Right, Left, 
Right, Bottom Left, Bottom (center), and Bottom Right.

Since legends take up space, the drawn chart will be smaller if you have selected the Visible 
check box. To increase the size of the chart, do not select the Visible check box or maximize 
the report window.

Formatting the chart legend
To format the chart legend:

1. Select the Visible check box to make the legend of the chart display on the report.

2. Select the Location (Top Left, Top, Top Right, Left, Right, Bottom Left, Bottom, or 
Bottom Right) where you want the legend to display on the chart.

3. Do one of the following tasks:

● Select Apply to make the changes and to keep the Chart Format Options window 
open.

● Select OK to make the changes and to close the Chart Format Options window.
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Series Labels tab
Use the Series Labels tab to edit the labels, or headings, that are assigned to each data item 
that is used in a chart.

Example

Series Labels tab option
You can specify the following parameters:

● Labels table - Shows the labels that are currently used in the chart. To edit the text, place the 
cursor in the Label column and type the appropriate information.
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Editing data item headings
To edit data item headings:

1. Place the cursor in the table cell that contains the heading, or label, you want to modify.

2. Enter the new name or edit the existing name.

3. Do one of the following tasks:

● Select Apply to make the changes and to keep the Chart Format Options window 
open.

● Select OK to make the changes and to close the Chart Format Options window.

Title tab
Use the Title tab to control the location of the chart title.

Example
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Title tab options
The following options are available on the Title tab:

● Visible check box - Allows you to display or not to display the report titles.

● Location - If you elect to have report titles visible, you can select where the titles are 
displayed. The available options are Top Left, Top (center), Top Right, Left, Right, Bottom 
Left, Bottom (center), and Bottom Right.

Since the title takes up space, the drawn chart will be smaller if you have selected the Visible 
check box. To increase the size of the chart, do not select the Visible check box or maximize 
the report window.

Formatting the title
To format the title:

1. Select the Visible check box to make the title of the chart display on the report.

2. In the Title text box, edit the content of the chart title.

3. Select the Location as Top Left, Top, Top Right, Left, Right, Bottom Left, Bottom, or 
Bottom Right where you want the title to be displayed on the chart.

4. Do one of the following tasks:

● Select Apply to make the changes and to keep the Chart Format Options window 
open.

● Select OK to make the changes and to close the Chart Format Options window.
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Type tab
Use the Type tab to change the chart type from 2-dimensional to 3-dimensional, and vice versa. 
You can also use this tab to specify the type of table you want. For example, you can choose a 
bar chart or a pie chart.

Example

Type tab options
The available options on the Type tab are as follows:

● 2D and 3D - Changes the chart to 2-dimensional or 3-dimensional views. 2D charts update 
faster than 3D charts, so if the drawing speed seems too slow, you may want to display 
charts as 2D.

● Chart Type - Specifies how the data is presented. You choose a chart type from the list. The 
types of charts available vary slightly depending on whether a 2D or 3D chart has been 
selected. All possible chart types are listed here:

- Bar Chart (2D and 3D)

- Line Chart (2D and 3D)

- Area Chart (2D and 3D)

- Step Chart (2D and 3D)

- Horizontal Bar Chart (2D and 3D)



Avaya CMS R17 Supervisor Report Designer November 2013 151

- Clustered Bar Chart (3D only)

- Pie Chart (2D and 3D)

● Stacked - Causes the data for all series to be stacked rather than shown separately. This 
check box is disabled for pie charts.

● % Axis - Causes the value axis (y-axis) to be displayed as percentages rather than as actual 
data values. This can be combined with the stacked format to produce a percentage stacked 
chart.

Selecting a chart type
To select a chart type:

1. Based on whether you want the report to display two-dimensionally or three-dimensionally, 
select 2D or 3D.

2. Select the Chart Type.

● The available types for two-dimensional charts are Bar, Line, Area, Step, Horizontal 
Bar, and Pie.

● The available types for three-dimensional charts are Bar, Line, Area, Step, Clustered 
Bar, Horizontal Bar, and Pie.

3. For any type of report other than Pie, you can select the Stacked check box to display all 
series together rather than separately.

If you select the Stacked check box, you can also select the % Axis check box, which 
causes the y-axis to be displayed as percentages rather than as data values.

4. Do one of the following tasks:

● Select Apply to make the changes and to keep the Chart Format Options window 
open.

● Select OK to make the changes and to close the Chart Format Options window.
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3D Effects tab
Use the 3D Effects tab to control the 3D appearance of the chart. If the current chart is a 2D 
chart, this tab is disabled.

Example

3D Effects tab options
You can change the following parameters:

● Elevation - This is a number from 0 through 90 degrees, and describes the relative height 
from which a chart is viewed. An elevation of 90 looks directly down on the top of the chart, 
while an elevation of 0 looks directly at the side of the chart. The example charts throughout 
this document use an elevation of 30 degrees.

● Rotation - This is a number from -360 through 360 degrees, and specifies the angle that the 
chart is turned relative to the viewing position. The example charts throughout this document 
use a rotation of 60 degrees. Rotation does not apply to 3D pie charts.

● Projection - This selects one of three mathematical algorithms used to give a 3D 
appearance on a 2D sheet of paper or computer screen. The following values can be 
chosen:



Avaya CMS R17 Supervisor Report Designer November 2013 153

- Oblique: The chart has depth but the X-Y plane does not change when the chart is 
rotated or elevated.

- Orthogonal: Perspective is not applied to the chart, resulting in less of a 3D effect. The 
advantage of this type of projection is that vertical lines remain vertical, making some 
charts easier to read.

- Perspective: This provides the most realistic 3D appearance. Objects farther away from 
you converge toward a vanishing point.

● Viewing Distance - This is a number from 50 through 1000 that represents the distance from 
which the chart is viewed as a percentage of the depth of the chart.

● Width to Height - This is a number from 5 through 2000 that represents the percentage of 
the chart’s height that is used to draw the chart’s width.

● Depth to Height - This is a number from 5 through 2000 that represents the percentage of 
the chart’s height that is used to draw the chart’s depth.
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Controlling the 3D appearance
To control the 3D appearance of the chart:

1. To change the degree of the top to bottom Elevation of the chart, enter a new number in the 
Elevation box.

2. To change the degree of Rotation of the chart, enter a new number in the Rotation box.

3. To change the type of Projection used for the chart, select a type from the Projection 
drop-down list.

4. Edit the ratios of width to height and depth to height, as appropriate.

5. Do one of the following tasks:

● Select Apply to make the changes and to keep the Chart Format Options window 
open.

● Select OK to make the changes and to close the Chart Format Options window.
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Chapter 12:Format | Table

This section describes the Format | Table menu option. 

Report Designer allows you to format report tables after they have been inserted on the report. 
You will use the Table option from the Format menu to edit tables on your designer reports. 

Organization of general information
This section includes the following general information:

● Information about how to format tables on page 156

● General tab on page 157

● Data tab on page 159

● Fonts tab on page 160

● Format tab on page 162

● Headers tab on page 164

● Sort tab on page 165

● Summary tab on page 167

Organization of procedures
This section includes the following procedures:

● Using the General tab on page 158

● Using the Data tab on page 160

● Using the Fonts tab on page 161

● Using the Format tab on page 163

● Using the Headers tab on page 165

● Using the Sort tab on page 166

● Using the Summary tab on page 168
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Information about how to format tables
If you are in a report that contains a table, you can format how the table displays and what is 
displayed in the table.

This section includes the following topics:

● About the Table Format Options window on page 156

● Accessing the Table Format Options window on page 156

● How your changes affect others on page 156

About the Table Format Options window
Use the Table Format Options window to make layout changes to a table. All changes made 
are saved as part of the report view when you save the report.

Accessing the Table Format Options window
You can access the Table Format Options window in any of the following ways:

● Double-click a column heading in the report.

● Select Format Table or Sort by from the Format menu list or the right mouse button pop-up 
menu.

How your changes affect others
The changes you make to a report’s format affect only your view of the report. The changes do 
not affect how other Supervisor users see the report.

If you select … Then the Table Format Option window is 
displayed with the …

Format Table General tab active

Sort by Sort tab active
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General tab
Use the General tab to make table format changes to gridlines, column and row scrolling, and 
orientation.

Example

General tab options
You can change the following table parameters:

● Show Gridlines - This specifies whether grid lines are shown in the table.

● Fixed Columns - This specifies the number of columns from the left of the table that are 
fixed in place and do not scroll. Valid values are in the range of 0 through 99. You can use the 
spin boxes to select a valid value or you can manually enter the value.

● Fixed Rows - This specifies the number of rows from the top of the table that are fixed in 
place and do not scroll. Valid values are in the range of 0 through 99. You can use the spin 
boxes to select a valid value or yoiu can manually enter the value.

● Orientation - Horizontal builds the table with the column names across the top of the table, 
so that the table reads from left to right. Vertical builds the table with the column names 
down the left side of the table, so that the table reads from top to bottom.
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Using the General tab
To use the General tab:

1. Select the Show Gridlines check box if you want the table to include lines between the 
columns and rows.

2. In the Fixed Region box, define the number of Columns on the table that will not scroll. 
You can enter the appropriate number or use the up and down arrows to select a valid 
number.

3. In the Fixed Region box, define the number of Rows on the table that will not scroll. You 
can enter the appropriate number or use the up and down arrows to select a valid number.

4. In the Orientation box, select Horizontal if you want the table to display with the column 
names across the top of the table. Select Vertical if you want the table to display with the 
column names down the left side of the table.

5. Do one of the following actions:

● Select Apply to make the changes and to keep the Table Format Options window 
open.

● Select OK to make the changes and to close the Table Format Options window.
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Data tab
Use the Data tab to add data items to, to remove data items from, and to reorganize the order of 
data items on the currently-selected table.

Example
.

Data tab options
You can specify the following parameters:

● Available Data - Lists all of the data items that are available, based on the query you used 
for the chart or table.

● Data on Table - Displays the data items that are currently used in the table.



 

160 Avaya CMS R17 Supervisor Report Designer November 2013

Using the Data tab
To use the Data tab window:

1. To add data items to the table, select an item from the Available Data list and select Add.

2. To remove data items from the table, select an item from the Data on Table list and select 
Delete.

3. To rearrange the order in which items appear on the table, select an item on the Data on 
Table list and use Up and Down to move the item to the appropriate place on the list.

4. Do one of the following actions:

● Select Apply to make the changes and to keep the Table Format Options window 
open.

● Select OK to make the changes and to close the Table Format Options window.

Fonts tab
Use the Fonts tab to edit the fonts of the data, headers, and summary information on the table 
report.

Example
.
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Fonts tab options
You can specify the following paramters:

● Fonts - Lists all of the available report items for which you can edit the fonts.

● Choose Font - Takes you to the Font selector window, where you can edit the font size and 
style for each type of text.

Using the Fonts tab
To change the fonts:

1. Select Choose font next to the report item that you want to change the font.

The Font window is displayed.

2. Select the Font, Font style, Size, Effects, Color, and Script that you want assigned to the 
selected text.

3. Select OK.

The Table Format Options window is displayed.

4. Do one of the following actions:

● Select Apply to make the changes and to keep the Table Format Options window 
open.

● Select OK to make the changes and to close the Table Format Options window.
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Format tab
Use the Format tab to alter the format of each column that is included in the table. The 
database items that make up the columns of the table are listed in the Item column in the Table 
section. For each Item, you can assign a variety of formatting characteristics.

Example

Format tab options
You can specify the following parameters:

● Item - Shows the database item, and table from which the data is retrieved, that is used for 
this column of the table.

● Show Value As - Use the drop-down list to select the format in which you want the value to 
be displayed. The Show Value As formatting applies only to data types that can be defined 
in the Dictionary.

● Align - Allows you to select the alignment of a field or column in a table. Available options for 
alignment are Left, Right, and Center.

● Format - The options available for the format will depend on the type of item you want to edit. 
For instance, a field that displays time will allow you to choose from a variety of time formats. 
A field that is a number will allow you to choose from a variety of number formats.
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● Show All Formats - You can select the Show All Formats check box to display the formats 
that are available for all field types. This check box is active only during the current use of the 
Format Table window. The next time you access the window, the check box will not be 
active.

● Zeros as Blanks - Select this check box to display cells on the table that contain zeros as 
blank. If you do not select the check box, the cells that contain zeros will display zeros.

● Merge with Next - Select the check box to merge this column with the column to the right on 
the table.

Using the Format tab
To edit the formatting on a table:

1. In the Item column of the table, select the data item that you want to edit.

2. In the Show Value As column, use the drop-down list to select how you want to have the 
data item displayed. The available values vary, depending on the data item.

3. In the Align column, use the drop-down list to select how you want the data item to be 
aligned on the table. Available values are Left, Right, and Center.

4. In the Format column, if available, select the time format or the number format as 
appropriate in which you want the data item displayed. The available choices reflect the 
specific data item you are formatting.

5. In the Show All Formats column, select the check box if you want the Format column to 
display all of the available data formats, regardless of the type of data item that you have.

6. In the Zeros as Blanks column, select the check box if you want to display cells on the 
table that contain zeros as blank. If you do not select the check box, the cells that contain 
zeros will display zeros.

7. In the Merge with Next column, select the check box to merge this column with the column 
to the right.
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Headers tab
Use the Headers tab to turn table headers on and off and to edit the text that appears in each 
column heading of the table.

Example

Headers tab options
You can specify the following parameters:

● Header Option - Select the Show Headers check box if you want the table report to include 
the headers.

● Table Header - This table shows the column headings that are currently used on the report.
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Using the Headers tab
To change the column headings on the table:

1. Place the cursor in the table cell that contains the heading you want to modify.

2. Enter the new name or edit the existing name.

3. Do one of the following tasks:

● Select Apply to make the changes and to keep the Table Format Options window 
open.

● Select OK to make the changes and to close the Table Format Options window.

Sort tab
Use the Sort tab to specify the order in which the information on the real-time table report is 
displayed.

Example

Sort By Criteria Sort Order
Drop-Down Lists
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Sort tab options
You can specify the following parameters:

● Sort By - When you set up display order for a real-time report, specify the sort column under 
Sort By and the sort order as Ascending or Descending. The drop-down list for Sort By 
lists all of the database table and item names used in the report.

Using the Sort tab
When you set up display order for a report, specify the sort column under Sort By and the sort 
order as Ascending or Descending. The drop-down list for Sort By lists all of the database 
table and item names used in the report.

Some examples of sorting are as follows:

● Viewing a list of agents alphabetically on page 166

● Searching for agents on page 166

Viewing a list of agents alphabetically
To view a list of agents alphabetically:

1. Select Name from the first Sort By drop-down list.

2. Select Ascending as the sort order.

3. Leave the other two Sort By boxes set to (none).

Searching for agents
To search for agents who have been in a certain state for too long:

1. Select WORKMODE from the first Sort By drop-down list

2. Select TIME from the second Sort By drop-down list

3. Select Descending as the sort order for the second Sort By.

Sorting may cause the report to take longer to refresh. If you want to speed up the refresh rate, 
select (none) for all of the Sort By criteria to turn off the sort options.
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Summary tab
Use the Summary tab to include or exclude summary lines from the currently-selected table. 
You can include a summary line for each query that is used in the report.

If this table includes an integrated query, the Summary tab will not display.

Example

Summary tab options
You can specify the following parameters:

● Summary Options - Allows you to include or exclude summary (totals) lines on table 
reports.
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Using the Summary tab
To include a summary line:

1. Select Show Summary.

2. Select a query from the Query box.

3. Select Top or Bottom, based on where you want the summary line to be located.

4. Do one of the following tasks:

● Select Apply to make the changes and to keep the Table Format Options window 
open.

● Select OK to make the changes and to close the Table Format Options window.
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Chapter 13:Format | Field

This section describes the Format | Field menu option.

Use Report Designer to format report fields after they have been inserted on the report. You will 
use the Field option from the Format menu to edit fields on your designer reports.

Organization of general information
The Field Format Options window on page 170

Organization of procedures
This section includes the following procedures:

● Creating or changing a label for the field on page 171

● Editing the format of a field on page 172
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The Field Format Options window
Use the Field Format Options window to choose the formats for fields defined in queries. To 
open the Field Format Options window, select Field from the Format menu. 

Example

Field Format Options field descriptions
The Field Format window includes the following options:

Field Description

Visible check box Allows to display or not display report legends.

Location of legend as:
● Above
● Left
● Right
● Below

Allows you to select where the legend displays if you 
choose to display report legends.
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Creating or changing a label for the field
To create or change a label for the field:

1. Select the field on the report.

2. Select Field from the Format menu.

The Field Format Options window is displayed. This window allows you to create a label 
or heading for the field, and to edit the format of the field itself.

3. From the Field Label box, select the Visible check box.

4. Select the location (Above, Below, Left, or Right) where you want the label to appear.

5. In the Label field, enter the words that you want the label to display.

6. To change the font of the label, select Font to access the Font window.

7. Do one of the following tasks:

● Select Apply to make the changes and keep the Field Format Options window open.

● Select OK to make the changes and to close the Field Format Options window.

Label Enter a brief description of the field. For example, for a 
field that displays the name of the split/skill for which the 
report was run, you might label the field Split/Skill.

Font (in the Field Label box) Opens the Font window, which allows you to change 
any of the font attributes for the field label.

Format Provides a drop-down list to select the format which you 
want the value to be displayed.

Align Allows you to select the alignment of a field or column in 
a table. Available options for alignment are left, right, 
and center.

Show Value as Name  Shows the field as name.

Font (in the Field Content 
box)

Opens the Font window, which allows you to change the 
font attributes for the field content.

Field Description



 

172 Avaya CMS R17 Supervisor Report Designer November 2013

Editing the format of a field
To edit the format of a field on your report:

1. Select the field on the report.

2. Select Field from the Format menu.

The Field Format Options window is displayed. This window allows you to create a label 
or heading for the field, and to edit the format of the field itself.

3. From the Format drop-down list, select the format in which the field will display.

The options available for the field format will depend on the type of field you want to edit. 
For instance, a field that displays time will allow you to choose from a variety of time 
formats. A field that is a number will allow you to choose from a variety of number formats.

You can select the Show All Formats check box to display the formats that are available for 
all field types.

4. .To align the field, select Left, Right, or Center from the Align drop-down list.

5. Select the Show Value as Name check box if you want to edit a field that displays an Avaya 
Call Management System (CMS) entity (split/skill, agent, and so on) that can be named in 
the Dictionary and you want the Dictionary name for the field to display instead of the 
number.

6. To change the font of the field, select Font to access the Font window.

7. Do one of the following tasks:

● Select Apply to make the changes and to keep the Field Format Options window open.

● Select OK to make the changes and to close the Field Format Options window.
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Chapter 14:Format | Text

This section describes how to use the Format | Text menu option.

Report Designer allows you to format the font style and size of text that appears on a report. 
You will use the Text option from the Format menu to edit text on a report.

This section includes the following topics:

● The Text Format Options window on page 173

● Formatting text on page 174

The Text Format Options window
To open the Text Format Options window, select a text item on the report and then select Text 
from the Format menu. The Text Format Options window allows you to change the font 
display characteristics for the selected text.

Example

Text Format Options parameters
You can specify the following parameters:

● Text contents - Enter the word or phrase that you want to insert on the report in this text box.
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● Text font - Opens the Font window, which allows you to change the Font, Font style, Size, 
Effects, Color, or Script box.

Formatting text
To format text on a report:

1. Select the text on the report.

2. Select Text from the Format menu.

The Text Format Options window is displayed.

3. Select Font.
The Font selector window is displayed.

4. Select the Font, Style, Point size, Effects, and Script that will apply to the text string you 
want to edit.

5. Select OK.

The Font selector window is closed.

6. Do one of the following tasks:

● Select Apply to make the changes and to keep the Text Format Options window open.

● Select OK to make the changes and to close the Text Format Options window.
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Appendix A: Error messages

This section describes Report Designer error messages and what to do to resolve the error 
messages. 

The errors described in this section usually are the result of a problem in the query that you 
want to test.

This section includes the following general information:

● Phase 1 error messages on page 176

● Phase 2 historical report error codes on page 177

● Phase 3 real-time report error codes on page 181
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Phase 1 error messages
This section contains information about Phase 1 error messages. 

The following table lists the phase 1 error messages alphabetically, and includes a cause and a 
recommended solution for each message.

Message Cause Solution

$<variable name> not defined The WHERE clause contains a 
variable that is not defined.

Define the variable using the 
define input action or remove the 
variable from the row search 
criteria.

Cannot mix aggregates and 
nonaggregates in the select

You cannot specify both 
aggregate columns and 
nonaccredited columns in the 
same select for real-time 
reports.

Create two identical row search 
conditions and apply one to the 
aggregate columns and one to 
the nonaccredited columns.

Cannot use the SYN function 
for order by

You cannot use a synonym to 
sort the output in the query.

Remove the aggregate from the 
Order by field. Use grid sorting 
to order the item.

Avaya CMS system error - 
Check the error log

An Avaya Call Management 
System (CMS) system error 
occurred while the select 
executed. The error should be 
recorded in the error log.

Verify the error in the error log to 
initiate corrective action.
If you run a report that merges 
data from two tables (particularly 
tables with large amounts of 
data) into a single field and your 
Select rows where statement is 
not specific enough, you may get 
this error message. The specific 
cause may be that the number of 
selected rows is very large, and 
CMS does not have enough 
space to create temporary files. If 
this is the case, you should add 
additional WHERE clauses to the 
row search criteria.

Avaya CMS system error - Data 
collection off

CMS cannot test the row 
search criteria while data 
collection is off.

Turn data collection on and rerun 
test of report design.

Avaya CMS system error - Too 
much data retrieved - try a more 
restrictive search

Too much data was retrieved 
with the given row search 
criteria.

Add more conditions to the row 
search criteria so that fewer rows 
are retrieved.
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Phase 2 historical report error codes
This section contains the CMS database error codes that are most likely to appear for CMS 
historical reports.

This section includes the following topics:

● Format on page 177

● List of phase 2 error codes on page 178

Format
These errors are reported in the following format:

INFORMIX error: <error number>

In addition, a circumflex (^) may appear to mark the location of an error.

Related topic
If an error code appears that is not listed in this document, see the INFORMIX SQL Relational 
Database Management System Reference guide for INFORMIX SQL.

Avaya CMS system error - 
Updating translations

CMS cannot test the row 
search criteria while CMS is 
receiving the set of 
configuration data from the 
communication server.

Wait until configuration data has 
been sent. Then rerun the test of 
report design.

keyword <variable> invalid in 
where clause

You cannot use the specified 
keyword in a row search 
criteria.

Remove the specified keyword 
from the row search criteria.

Message Cause Solution
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List of phase 2 error codes
The following table describes each phase 2 error code and the recommended corrective action.

Error Description Solution

201 A syntax error has occurred. Verify that you have not misspelled an RDSQL 
statement, placed key words out of sequence, or 
included an SQL reserved word in your query.

202 An illegal character has been found 
in the statement.

Remove the illegal character (often a nonprintable 
control character) and resubmit the statement.

203 An illegal integer has been found in 
the statement.

Integers must be whole numbers from -2,147,483,647 
to 2,147,483,647. Verify that you have not included a 
number with a fractional portion or a number outside 
the acceptable range. Verify also that you have not 
inadvertently entered a letter in place of a number (for 
example, 125p3 instead of 12503).

204 An illegal floating-point number has 
been found in the statement.

Verify that you have not inadvertently entered a letter in 
place of a number (for example, 125p3 instead of 
125.03).

206 The specified table name is not in 
the database.

Verify the spelling of the table name in your statement.

217 Column column-name not found in 
any table in the query.

Correct the spelling of the database item and ensure 
that the item exists in the database table. Verify for the 
presence of required commas and quotes.

219 Wildcard matching may not be used 
with noncharacter types.

Wildcards (*, ?) and characters enclosed in brackets [ ] 
can be used only with CHAR data types. Verify the data 
type for the offending column.

220 There is no “FROM” clause in the 
query.

You must include a FROM clause in the query. Verify 
that you do not have an illegal character ($, #, &, and 
so on) or a CONTROL character in the line prior to the 
FROM keyword.

223 Duplicate table name table-name in 
the FROM clause.

Remove the redundant table name from the statement 
or use an alias to rename one of the tables.

228 Cannot have negative characters. Verify that you have not included a negative CHAR 
data type (for example, -a or -p) in your statement.

278 Too many ORDER BY columns; 
maximum is eight.

Reduce the number of columns included in the ORDER 
BY clause to eight or fewer.
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280 Total size of ORDER BY columns 
exceeds 120 bytes.

Reduce the number of columns included in the ORDER 
BY clause so that the total number of characters is 
fewer than or equal to 120 (perhaps delete a CHAR 
column of 30 or more characters).

282 Found a quote for which there is no 
matching quote.

Verify that all quoted strings are properly terminated 
with a quote.

284 A subquery has not returned 
exactly one value.

Verify data for the subquery. Restructure the subquery 
by adding more components in the WHERE clause so 
that only one value is returned.

297 The SELECT list may not contain a 
subquery.

Remove the subquery from the SELECT list in the 
statement.

300 There are too many GROUP BY 
columns (maximum is eight).

Reduce to eight or fewer the number of nonaggregate 
database items that are assigned the same row search 
ID as that assigned to an aggregate function.

301 The total size of the GROUP BY 
columns exceeds 120 characters.

The total number of characters in all columns listed in 
the GROUP BY list exceeds 120 characters. Reduce 
the number of nonaccredited database items that are 
assigned to a row search ID that is also assigned to an 
aggregate function.

303 Expression mixes columns with 
aggregates.

Restructure your query so that columns and 
aggregates are not included in the same expression.

309 ORDER BY database item must be 
included in a report field to which 
the row search ID is assigned.

Verify that database items included in the ORDER BY 
clause appear in the report and are assigned to row 
search ID.

324 Ambiguous database item. A database item in your row search criteria exists in 
more than one table also cited in your row search 
criteria. Precede each database item with the 
appropriate table name.

352 Database item not found. Verify the spelling of the database item.

367 Sums and averages cannot be 
computed for character columns.

Verify that you have not included a database item of a 
string type (VDN, LOGID, and so on) in the aggregate 
function statement.

522 A database item in a field/bar does 
not exist in the table specified in the 
field’s row search ID.

Verify the Select statement that has the error. The 
database item that does not exist in the table will be 
marked with a circumflex (^). Change or delete the 
database item or change the table in the field’s row 
search ID.

809 RDSQL syntax error has occurred. Verify that you have not misspelled an RDSQL 
statement, placed key words out of sequence, or 
included an SQL reserved word in your query.

Error Description Solution
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1202 An attempt was made to divide by 
zero.

Verify that you are not attempting to divide a numerical 
column type by a character column type (for example, 
16/Jones). Also verify that the value of the divisor does 
not equal zero.

1203 Values used in a MATCH must both 
be type CHARACTER.

Verify that the values included in your MATCH 
condition are both CHAR types. Use an alternate 
comparison condition for non CHAR types.

1204 Invalid year in date. Acceptable years are 0001 to 9999. If two digits are 
used, RDSQL assumes that the year is 19xx. Verify the 
value entered in the date field.

1205 Invalid month in date. Months must be represented as the number of the 
month (01 through 12). Verify the value entered in the 
date field.

1206 Invalid day in date. Days must be represented as the number of the day 
(01 through 31). Verify the value entered in the date 
field.

1226 Decimal or money value exceeds 
maximum precision.

Increase the precision of the DECIMAL or MONEY 
field.

Error Description Solution
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Phase 3 real-time report error codes
Phase 3 real-time report error codes contains the Real-Time Database Manager error codes. 
Each code includes a description of the error and a recommended solution.

This section includes the following topics:

● Format on page 181

● List of phase 3 error codes on page 181

Format
These errors are reported in the following format:

Avaya CMS Database Manager error: <error number>

In addition, a circumflex (^) appears to mark the location of an error.

List of phase 3 error codes
The following table describes each phase 3 error code and the recommended corrective action.

Error Description Solution

1 A syntax error has occurred. Verify the select for misspelled keywords or keywords that 
are out of order.

2 An illegal character has been 
found in the select statement.

Remove the illegal character (often a nonprintable control 
character).

3 The specified table name is 
invalid.

Verify the spelling of the table name and verify that you 
have included required commas in the From tables field.

4 An invalid column has been 
specified (it is not found in any 
of the specified tables).

Verify the spelling of the column names.
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5  A mixture of aggregates and 
nonaggregates are being 
selected, and this is not allowed 
in real-time reports. (This error 
code can also mean 
mismatched types in 
comparison.)

Create two identical row search conditions, and apply one 
to the aggregate columns and one to the nonaccredited 
columns.

6 Bad column in the order by 
clause.

Verify that the column name in the order by clause is 
spelled correctly and that it is being selected by one of the 
fields included in this row search.

7 Bad index in order by clause. Verify that the order by clause has a column in the 
SELECT clause or a number that indicates a position of 
the column in the select clause.

8 Bad argument given to an 
aggregate function. For 
example, you cannot take the 
SUM or AVG of a character 
column.

Verify the arguments for the aggregates and be sure that 
data type is appropriate.

9 In the Select of one of the fields 
associated with this row search, 
an action is being performed 
with the wrong data types. For 
example, you cannot use 
arithmetic with character fields.

Verify for these types of errors in the fields associated with 
the row search.

10 Error with subquery There may be a subquery in the WHERE clause that CMS 
does not support. Verify the subqueries. This typically 
happens with an Agent Group report (a SELECT 
embedded within a SELECT).

11 Avaya CMS system error Verify the error logs.

12 Memory allocation error Verify the error logs.

13 Query cannot select more than 
one table.

Verify the error logs.

Error Description Solution
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Appendix B: How CMS stores and retrieves 
data

The most important and difficult part of designing a report is defining the data that goes into the 
report. To define report data, you must first understand how the Avaya Call Management 
System (CMS) stores and retrieves data. 

This section includes the following topics:

● How CMS stores data on page 183

● How CMS retrieves data on page 184

How CMS stores data
This section includes the following topics:

● Table on page 183

● Database items on page 184

● Row on page 184

● Index on page 184

Table
CMS stores data in a CMS database that is divided into 52 different tables. A table is an array of 
columns and rows that stores data for a type of ACD element (split/skill, agent, trunk, trunk 
group, VDN, vector, call work code, forecasting, agent trace, call records, or exceptions) and for 
a specific time frame (for the current intrahour interval, for past intrahour intervals, for past day, 
summarized by day, and so on). If data in a table is in real time, data changes second by 
second.
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Database items
The CMS database uses names to refer to columns of data in a table. These names are called 
database items. For a complete listing of database items, see the Avaya CMS Database Items 
and Calculations document.

Row
Each row in a table contains data that is related by the values of one or more of the columns. 
For example, each row in the Current Interval Agent table contains data related by agent login 
ID.

Index
A column that causes the values in a row to be related is called an index. An index stores data 
sequentially and adds structure for the storage of data in the other columns. For each value in 
an index column, the remaining values in the corresponding row are related to that value.

How CMS retrieves data
This section includes the following topics:

● Three types of information on page 184

● How to tell CMS to retrieve data on page 185

● Identify rows on page 185

● Indexes for search on page 185

● About creating new database tables on page 186

Three types of information
CMS retrieves data from the database based on the following types of information that you 
supply when you design a report:

● The name of the table
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● The database items in the table

● The rows of data in the table

How to tell CMS to retrieve data
To tell CMS how to retrieve data, you must tell CMS to access the appropriate database table. 
Then, for each report field, you assign the appropriate database items. When you run the report, 
CMS will find in the table the columns of data associated with the database items.

Identify rows
Next, you identify the appropriate rows that supply data. If you want agents in Split 1, you must 
tell CMS to find rows that have the value 1 for the SPLIT database item. When you run the 
report, CMS finds the appropriate rows of data in the cagent table.

The data that CMS reports is the data found in the intersection of the selected database items 
and rows. Therefore, the report shows data that is similar to the data shown in this figure.

Actually, when you design a report, you normally set up the row selection so that the users 
running the report can choose the rows in the report's input window. For example, to run the 
report in the previous figure, you would set up the row selection so users would fill out a Report 
Input window that asked them for a Split number.

Indexes for search
CMS uses indexes to create a structure for storing data. Similarly, CMS uses these indexes to 
search for data. Indexes allow CMS to find data much faster than if data were stored more 

Split: 1

Current ACD ACD Average
Agent ID: State Calls Time Talk Time
1001 AVAIL 21 988 47:00
1002 AVAIL 19 777 40:09
1003 ACD 15 400 26:07
1004 ACD 9 58 6:44
1005 ACD 11 644 58:54
1006 AUX 20 245 12:25
1008 ACW 18 603 33:50
1010 AVAIL 18 203 11:28
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randomly. Therefore, when you design a report, the rows of data for the report should be 
defined on the basis of index values.

About creating new database tables
The indexes for each standard table are fixed and cannot be changed or deleted. However, if 
you define a custom table in the CMS database through SQL, you can define any indexes 
desired for that new table.

Example
As an example of how CMS retrieves report data, if you want a custom intrahour interval split 
report that lists, by intrahour interval, data for a split in a single day, you must tell CMS to access 
the hsplit (Historical Intrahour Interval Split) table. You must then assign the appropriate 
database items to the fields. When you run the report, CMS finds the columns of data 
associated with the database items in the hsplit table.

Next, you must identify the appropriate rows that supply data. You might want data for the 
following items:

● Split 1, which means you must identify rows that have the value 1 for the SPLIT database 
item.

● The date 07/02/02, which means you must identify rows with the value 070202 for the 
ROWDATE database item.

● The intrahour intervals 8:00 a.m. to 11:00 a.m., which means you must identify rows with the 
values 0800 through 1100 for the one database item.

CMS then finds the appropriate rows of data.

The data that CMS reports is thle data found in the intersection of the selected database items 
and columns.

Defining data is the central task of creating and designing a report. However, you must do many 
other tasks to create a report.

Split: 1
Date: 07/02/02

ACD
Interval Calls Abandons
08:00am 399 36
09:00am 400 46
10:00am 394 40
11:00am 418 41
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Appendix C: Report Designer examples

This section provides examples to help you create and modify reports with Report Designer. 

This section includes the following topics:

● Creating an integrated report on page 187

● Modifying an integrated report on page 189

● Creating an expanded AUX reason code report on page 190

Creating an integrated report
The following procedure shows how to create an integrated report in Report Designer that 
displays agent states.

To create an integrated report that displays agent states:

1. From the toolbar, select Reports.

The Select a Report window is displayed.

2. Select New.

The Design Mode window is displayed.

3. From the Edit menu, select Inputs. 

The Edit Inputs window is displayed.

4. From the Input Types list, select Split/Skill, and select Add.

5. Select OK.

6. From the Edit menu, select Queries. 

A Query Assistant window is displayed.

7. Select New. 

8. In the Database frame, select Integrated.

9. Under the Table Name column, select the isplit table name, and select Next.
10. From the Database Items list, select on the item to select the following database items:
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● Abncalls
● Acdcalls
● Acdtime
● Servicelevel

11. Select Add.

12. Select Next.
13. Select Input Start Time, and select Next. 
14. Select the Split/Skill input, and select Next.
15. Name your query chart, and select Done.

16. Close the Query Select window. 

The Design Mode window is displayed.

17. From the Report menu, select Save As.

18. Name your report <your name> status, and select Only Me. 

19. Select OK. 

Notice that your report is now displayed in the Integrated Designer Category.

20. From the Insert menu, select chart.
The Chart Assistant window is displayed.

21. From the Queries drop-down list, select chart.

22. Select Add All. 
All data are added to the Data on Chart list.

23. Select Next.
24. Select 2D.

25. Select Bar Graph for your chart type, and select Next.
26. Select (none) in the Available Data list, and select Done.

27. Save your report.
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Modifying an integrated report
This section describes how to modify an existing report with Report Designer.

To modify an existing report:

1. From the Select a Report window, select the Integrated tab.

2. In the Category list, select Designer.
3. In the Report list, select the report you just created, and select Edit.
4. From the Edit menu, select Queries.

A Query Assistant window is displayed.

5. Select New.

6. In the Database frame, select Integrated.

7. Under the Table Name column, select the isplit table name, and select Next.
8. From the Database Items list, select on the item to select the following database items:

● AVAILABLE
● AGINRING
● INACW
● INAUX
● O_ONACD
● OTHER

9. Select Add.

10. Select Next.
11. Select Input Start Time, and select Next.
12. Select the Split/Skill input, and select Next.
13. Name your query table, and select Done.

14. Close the Query Select window. 

The Design Mode window is displayed.

15. From the Report menu, select Save.

16. From the Select a Report window, select the Integrated tab.

17. In the Category list, select Designer.
18. In the Report list, select the report you just created, and select Edit.
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19. From the Insert menu, select Table. 

The Table Assistant window is displayed.

20. From the Queries drop-down list, select table, and select Add All.
21. Select Next.
22. In the Orientation frame, select Vertical.
23. In the Options frame, select Headers On and Grid Line On.

24. Select Done.

Your report now has a chart and a table.

25. Move the table so that you can see both the chart and table. By default, the second section 
(your table) will overlay the first section (your chart).

26. From the Report menu, select Save.

Creating an expanded AUX reason code report
The standard CMS Supervisor reports for CMS include a new field for the Expanded AUX 
feature. The field contains the combined calculated time for AUX reason codes 10 through 99. 
This field will be in any reports that display time in AUX. If you need your report to include 
specific AUX reason codes, you should create a custom report or modify an existing standard 
report. 

The following report is an example of the type of custom report you can create with Report 
Designer when you use the following procedure:

1. Open the CMS Supervisor interface and locate the Commands option on the menu bar.

2. Select Commands > Reports.

The system displays the Report selector window.

3. Select New.

The system displays a prompt to run the report wizard.

4. Select No.

The system displays the Report designer window.

5. Select from the menu bar Edit > Inputs.

The system displays the Edit Inputs window.

6. Select Agent in the Input Types list, and then select the Add button.

7. Select Date in the Input Types list, and then select the Add button.
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8. Select the OK button.

The system returns to the Report designer window.

9. Select from the menu bar Edit > Queries.

The system displays the Query Select window.

10. Select the New button.

The system displays the Query Assistant Window.

11. Locate the Database section, and select Historical.
12. Locate the table section, and select Agent Daily.

13. Select the Next button.

14. Locate the Database Items list.

15. Select each of the following database items, and add the item to the Query Items list by 
selecting the Add button.

● TI_AUXTIME
● TI_AUXTIME0 through 

● TI_AUXTIME99
16. Select Next.

The system displays the Query Assistant window.

17. Select Next.
The system displays the Query Assistant window.

18. Locate the Operand1, Operator, and Operand2 lists.

19. Scroll through the lists and select:

● LOGID as Operand1

● = as the Operator

● [Agent] as Operand2

20. Select the AND button.

21. Scroll through the lists and select:

● ROW_DATE as Operand1

● = as the Operator

● [Date] as Operand2

22. Select the AND button.

23. Select Next.
24. Enter a name for the query, or accept the default query name.
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25. Select Done.

The system displays the Query Select window.

26. Select Close.

The system redisplays the Report designer window.

27. Select from the menu bar Insert > Table.

The system displays the Table Assistant window.

28. Select your query in the Queries drop down list.

29. Select the Add all button.

30. Select Next.
31. Right-click on the table, and then select Format table.

32. Select Vertical in the Orientation section. 

33. Select Grid Lines on in the Options section.

34. Select the Done button.

35. Select from the menu bar Report > Run. 

36. Save the report when you exit.  Select from the menu bar Report > Exit.
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Glossary

ACD See Automatic Call Distribution.

Actions menu A menu in the upper-left corner of the Avaya CMS Supervisor Operations 
windows. The menu lists the actions available for that particular user window 
(for example, add, modify, and delete). You select an action after entering the 
necessary data in the user window.

Add An Avaya CMS Supervisor action that adds the data entered in the given 
window to the Avaya CMS database.

Add/Remove 
programs wizard

A Microsoft® Windows® feature that guides you through a series of steps in 
order to remove programs that have been installed on your computer. The 
Add/Remove icon is found in the Control Panel dialog box.

Administrator 
privileges

Permissions assigned to an Avaya CMS Supervisor user in order to 
administer specific elements, such as installing Avaya CMS Supervisor on a 
network. Access permissions are specified as read or write permission. Read 
permission means the user can only access and view Avaya CMS 
Supervisor data. Write permission means the Avaya CMS Supervisor user 
can add, modify, or delete Avaya CMS Supervisor data.

Agent A person who answers calls to an extension in an ACD split/skill. The agent 
is known to Avaya CMS by a login identification keyed into a voice terminal.

Agent reports A group of reports that give the status of agents in an agent group, selected 
splits or skills, or real-time information and statistics.

Agent skill An attribute that is associated with an ACD agent. Agent Skills can be 
thought of as the ability for an agent with a particular set of skills to handle a 
call that requires one of a set of skills. An agent can be assigned up to four 
skills. 

Application folder A folder on the network server that holds the Avaya CMS Supervisor 
application software -executables and components.



 

194 Avaya CMS R17 Supervisor Report Designer November 2013

Automatic Call 
Distribution (ACD)

A communication server feature that uses software to channel high-volume 
incoming and outgoing call traffic to agent groups (splits or skills). 
Also an agent state where the extension is engaged on an ACD call.

Automatic script An Avaya CMS Supervisor feature that launches a new Avaya CMS 
Supervisor session that logs into Avaya CMS and runs the requested tasks 
in the background. Actions do not display on the PC. See also Interactive 
Script and Script.

AutoPlay A Microsoft Windows feature that causes an application on a CD-ROM to run 
without any user interaction as soon as the CD-ROM is inserted into the 
drive.

Avaya Business 
Advocate

A collection of ECS features that provide new flexibility in the way a call is 
selected for an agent in a call surplus situation and in the way that an agent 
is selected for a call.

Avaya Call 
Management System 
(CMS)

A software product used by business customers that have Avaya 
communication servers and receive a large volume of telephone calls that 
are processed through the Automatic Call Distribution (ACD) feature of the 
communciation server. The Avaya CMS collects call-traffic data, formats 
management reports, and provides an administrative interface to the ACD 
feature in the communication server.

Avaya CMS See Avaya Call Management System.

Client A single PC that uses Avaya CMS Supervisor.

Controller An Avaya CMS Supervisor feature that allows the user to access Avaya CMS 
reports and operations. The Controller includes a toolbar, a menu bar, a 
status bar, tool tips, and indicators.

Custom reports Real-time or historical reports that have been customized from standard 
reports or created from scratch.

Database A group of tables that store ACD data according to a specific time frame: 
current and previous intrahour real-time data and intrahour, daily, weekly, 
and monthly historical data.

Database item A name for a specific type of data stored in one of the Avaya CMS 
databases. A database item may store ACD identifiers (split numbers or 
names, login IDs, VDNs, and so forth) or statistical data on ACD 
performance (number of ACD calls, wait time for calls in queue, current 
states of individual agents, and so forth).
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Database table Avaya CMS uses these tables to collect, store, and retrieve ACD data. 
Standard Avaya CMS items (database items) are names of columns in the 
Avaya CMS database tables.

Data points Points of historical data. A data point should include data for each interval of 
the working day.

Delete An Avaya CMS Supervisor action that removes the entry on the window from 
the Avaya CMS database.

Designer reports Customized reports that can be created with Avaya CMS Supervisor’s 
Report Designer feature. Designer Reports are run from Avaya CMS 
Supervisor.

Dialog box A small on-screen window that conveys or requests information from the 
user. This window can contain list boxes, text boxes, tabbed pages, and so 
forth.

Dictionary An Avaya CMS subsystem that can be used to assign names to various 
contact center elements such as login IDs, splits/skills, trunk groups, VDNs 
and vectors. These names appear on reports, making them easier to 
interpret.

Edit menu A menu on the Avaya CMS Supervisor Operations windows. The menu lists 
the actions available for that particular user window (for example, cut, copy, 
and paste). 

Exception A type of activity on the ACD which falls outside of the limits you have 
defined. An exceptional condition is defined in the Avaya CMS Exceptions 
subsystem, and usually indicates abnormal or unacceptable performance on 
the ACD (by agents, splits/skills, VDNs, vectors, trunks, or trunk groups).

Exceptions reports Display occurrences of unusual call-handling events.

Find one An Avaya CMS action that searches the database for entries thatch the input 
value.

Graphics An Avaya CMS reporting option that allows you to view some reports in bar 
graph format.

Grayed out When you do not have access to a menu or action list item, it will be dimmed 
or displayed in a different color from the rest of the menu or action list.
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Historical reports Display past ACD data for various agent, split/skill, trunk, trunk group, vector, 
or VDN activities. A report summary of call data into daily, weekly or monthly 
totals

HTML See HyperText Markup Language.

Hypertext A linkage between related text. For example, if you select a word in a 
sentence, information about that word is retrieved if it exists, or the next 
occurrence of the word is found.

HyperText Markup 
Language

A standard for defining documents with hypertext links. See also Hypertext.

Input field An area on window where you specify information that you want to view, add, 
modify, or delete.

Installation folder A folder on the network that holds all of the Avaya CMS Supervisor files. 
Setup.exe is run from this folder to install Avaya CMS Supervisor on each 
client computer.

Integrated reports Integrated reports compile contact center information from any starting point 
in the last 24 hours up to and including the current interval.

Interactive script An Avaya CMS Supervisor feature that runs the requested tasks in the 
current Avaya CMS Supervisor session and displays the actions on the PC. 
You can input requested information while the script is running. See also 
Automatic Script and Script.

Jump In Help, a command that moves you from the currently displayed topic to 
another topic.

LAN See Local Area Network.

List all An Avaya CMS action that lists all the entries that matched the current field 
values.

Local Area Network 
(LAN)

Two or more computers connected by cable and using a suitable operating 
system and application software so they can directly share hard disks, 
printers, and other peripherals, and files.

Local installation With this type of installation, you install all of the Avaya CMS Supervisor 
software to disk space on each local computer from a CD-ROM or from the 
network.
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Log A file that contains a record of computer activity as well as backup and 
recovery data.

Maintenance An Avaya CMS subsystem that is used for doing routine maintenance of the 
Avaya CMS, such as backing up data, checking on the status of the 
connection to the communication server, and scanning the error log.

Name fields Fields in which you may enter a name (synonym) that has been entered in 
the Dictionary subsystem (for example, names of agents, splits/skills, agent 
groups, trunk groups, vectors, VDNs).

Network server A computer in a network shared by multiple users.

Queue/Agent reports A group of reports that give the status of all top agents in a skill and queue 
status, or skill status for a selected skill.

Readme file A file that provides up-to-the-minute information on a newly released 
product; in this case, Avaya CMS Supervisor.

Read-only A folder or file that can be read, but not updated or erased.

Real-time reports Display current ACD call activity on agents, splits/skills, trunks, trunk groups, 
vectors, and VDNs for the current or previous intrahour interval. Current 
intrahour interval real-time reports are constantly updated as data changes 
during the interval. Previous intrahour interval real-time reports show data 
totals for activity that occurred in the previous intrahour interval.

Registry The system-wide depository of information supported by Microsoft Windows. 
The registry contains information about the system and its applications, 
including clients and servers.

Report Designer An Avaya CMS Supervisor feature that enables users to design their own 
reports.

Report Wizard An Avaya CMS Supervisor feature that delivers user assistance, by way of a 
wizard, to quickly and easily generate new customized reports. The wizard 
provides instructional help that guides the user through a series of tasks that 
create a new customized report. Report Wizard is a supplement to Report 
Designer.

Run A Microsoft Windows command that lets you execute a program, such as 
Avaya CMS Supervisor installation.
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Scripting An Avaya CMS feature that lets you automate actions such as changing an 
agent’s skills, running reports, exporting report data, and many other Avaya 
CMS functions. For example, you can create a script to run a specified report 
and export the data on schedule. 

Scroll To use the bar on the side of the report window to move forward, backward, 
up, or down within a window.

Setup program A program that configures a system for a particular environment; for 
example, it informs the system of a new device or interface, such as Avaya 
Framework.

Shared installation With this type of installation, the Avaya CMS Supervisor application software 
is installed to a shared application folder on the network server, but 
user-specific files and logs are stored in an Avaya CMS Supervisor folder on 
each user’s PC or on their own network drive.

Shortcut An icon on your computer screen that enables you to select and run an 
application (for example, Avaya CMS Supervisor) quickly and easily.

Skill An attribute that is assigned to an ACD Agent. Agent Skills can be thought of 
as the ability for an Agent with a particular set of skills to handle a call which 
requires one of those skills. 

Solaris system A multi-user operating system developed by Sun Microsystems. The 
operating system on which Avaya CMS runs.

Split A group of extensions that receives special-purpose calls in an efficient, 
cost-effective manner. Normally, calls to a split arrive primarily over one or a 
few trunk groups.

Standard reports The set of reports that are delivered with the Avaya CMS or Avaya CMS 
Supervisor software.

Start menu The menu that appears when you select Start in the Microsoft Windows 
taskbar. This menu contains programs and other Microsoft Windows 
applications.

Taskbar The bar that appears by default at the bottom of the Microsoft Windows 
desktop. You can select buttons that appear on this bar to switch between 
running programs.

Terminal A combination of monitor (video display) and keyboard used to communicate 
with a remote computer to enter and display information. 
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Terminal emulator An Avaya CMS Supervisor software application that emulates a 615 Color 
(615C) terminal.

Toolbar A row of controller buttons used to activate various functions of the Avaya 
CMS Supervisor application.

Tooltips Brief descriptions that display when the mouse pointer is over a toolbar 
button.

Trunk group report Displays the status of each trunk in a selected trunk group.

User ID The login ID for an Avaya CMS user.

VDN See Vector Directory Number.

VDN reports A group of reports that show profiles of current VDN performance, call 
handling information for a specific VDN based on skill preference, and how 
calls to specific VDNs have been handled.

Vector A list of steps that process calls in a user-defined manner. The steps in a 
vector can send calls to splits, play announcements and music, disconnect 
calls, give calls a busy signal, or route calls to other destinations. 

Vector Directory 
Number (VDN)

An extension number that enables calls to connect to a vector for processing. 
A VDN is not assigned an equipment location. It is assigned to a vector. A 
VDN can connect calls to a vector when the calls arrive over an assigned 
automatic-in trunk group or when calls arrive over a dial-repeating (DID) 
trunk group and the final digits match the VDN.

Vector report A report that lists the number of calls to specific vectors.

Window A rectangular, on-screen frame through which you can view a menu, data 
entry fields, reports, or messages.

Wizard A tutor built into the software that guides you through procedures.
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